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Chapter 1: Introduction

Welcome to IDEAS® 6.3

Welcome to the IDEAS® version 6.3 software manual for ImageStream® and FlowSight® data analysis.

Description
This manual provides instruction for using the Amnis® IDEAS® application to analyze data files from the ImageStream® 
and FlowSight® cell analysis systems.

The intuitive user interface of the IDEAS application makes it easy for you to explore and analyze data. The application 
can quantify cellular activity by performing statistical analyses on thousands of events and, at the same time, permit 
visual confirmation of any individual event. Furthermore, you can operate the application in a batch processing mode and 
store specific analysis templates for either repeated use or sharing with colleagues. 

The fastest way to put the IDEAS application to work is to first skim through this manual—becoming familiar with the 
application’s structure, compensation, file types, and analysis tools—and then use the application wizards on some 
sample experimental data to begin exploring the power that the application provides. This manual has been integrated 
into the IDEAS application to provide searchable and context sensitive help. Typing F1 while in the application opens the 
help files.
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Materials Provided
 l IDEAS® 6.3 software

Materials Required but Not Provided
 l ImageStream® or ImageStreamX® instrument

 l OR FlowSight® instrument

Set Up the IDEAS® Application

This chapter describes the hardware and software requirements for the application, which includes the procedures for 
installing, removing, and upgrading the application. 

Hardware and Software Requirements
This section states the minimum and the recommended hardware and software requirements for running the IDEAS® 
6.3 application.

Hardware Requirements
The minimum hardware requirements are 4 GB of RAM and a dual core Intel processor. However, due to the large size 
of the image files that the ImageStream® cell analysis system creates, a larger amount of RAM will prevent paging and 
thus increase performance.

Software Requirements
IDEAS 6.3 64-bit version requires that the Windows® 7 or later operating system be installed on your computer. IDEAS 
6.3 32-bit version requires Windows XP, Windows 2000 or later version of the operating system. The latest service 
pack and any critical updates for the operating system must be included. You must also install the Microsoft® .NET 
Framework 2.0, which requires Microsoft Internet Explorer 5.01 or later.

NOTE: If the software requirements are not met, Setup will not block installation nor provide any warnings. 
NOTE: Service packs and critical updates are available from the Microsoft Security Web Site.

Install the IDEAS® 6.3 Application
NOTE: If the IDEAS® 6.3 software has previously been installed, the previous version will be removed during install-
ation.
1.   Download the application Setup file from your account at www.luminexcorp.com.
2.    View the contents of the Setup file in My Computer or Windows® Explorer.
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3.    Double-click Setup.exe.
4.    Follow the instructions until the installation process has completed.
5.    MadCap help viewer is installed and opened during installation or upgrade.
6.    Select the language and check box to not show this dialog again.
7.    An icon appears on the desktop and IDEAS Application appears on the All Programs menu.

Set Your Computer to Run the IDEAS® Application

Set the Screen Resolution
Confirm that the screen resolution is adequate for the IDEAS® 6.3 application. To be able to view the entire application 
window, you must set the width of the screen resolution to a minimum of 1024 pixels.

1.   From the Start menu, select Control Panel, and then click Display.
2.    Click the Settings tab to set the screen resolution.

View File Name Extensions
When loading a file, the IDEAS® application uses the file name extension to determine the file type. It will be easier for 
you to distinguish raw image files, compensated image files, and data analysis files from each other if Windows Explorer 
does not hide the extensions.

1.   In Windows® Explorer, go to Tools > Folder Options.
2.    Click the View tab, and make sure that the Hide extensions for known file types check box is not selected.
3.    Click OK.

Copy the Example Data Files
Copy data files to a single directory on your hard drive. Sample data files are available on your workstation or at the 
Luminex website  for customers with an  account.

1.   Copy the data files.
2.    Right-click the directory that contains the data files, and click Properties.
3.    Clear the Read-only check box.
4.    Click OK.
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View and Change the Application Defaults
To view or change these defaults, choose Application Defaults from the Options menu. Each tab allows you to view or 
change the default settings.

 l The Directories tab contains the default Data, Template, Batch or Compensation Matrix file directories.
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 l The Populations tab contains the default color or symbol for populations. To change the default settings, click 
on the color to or choose a default symbol from the list. 

 l The Masks tab contains the default mask color. To change the color of the mask click on the color button.

 l The Graph Display tab contains the default settings for graphs in the analysis area including graph size, font 
sizes and the default list of statistics shown for a graph. Check the box next to the statistic to have it show 
below the graphs when statistics are shown for a graph.  The settings may be updated on all or selected graphs 
in the analysis area.
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 l The Graph Export tab contains the default settings  for exporting graphs including the graph size, font size, 
options to include legend, cursor sample name and statistics. Select the Defaults button to use the graph 
export settings when exporting graphs or select the Graph button to use the settings as they appear in the ana-
lysis area for the graph.
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 l The Image Export tab contains the default settings  for image export when copying and pasting from IDEAS® 
for reporting into other programs.

 l The Colors tab contains the mapping of dark and light mode colors.

For Research Use Only. Not for use in diagnostic procedures. 7

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



Configure Licenses
To view or edit your installed licenses in IDEAS® 6.3, select Options > Configure Licenses.

NOTE: To activate machine learning, please contact your Luminex sales or support representative.
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Chapter 2: IDEAS® Overview

This chapter provides an overview of the IDEAS® application user interface, the files that the IDEAS application creates 
and uses, the recommended directory organization and an overview of the workflow.

Compensation, Analysis Tools, and File Structure Over-
view
The Luminex cell analysis systems possess unique capabilities that neither flow cytometry nor microscopy alone can 
deliver. The IDEAS® application provides an image gallery to view every cell in the data file along with linked graphical 
data for confident gating and image confirmation. The application contains powerful algorithms that facilitate and 
quantify the image analysis of ImageStream® and FlowSight® data. Examples include the analysis of molecule co-loc-
alization and translocation, the analysis of cell-to-cell contact regions and signaling interactions, the detection of rare 
molecules and cells, and a comprehensive classification of large numbers of cells. The IDEAS application acquires data 
from INSPIRE™, compensates the images, and allows the user to evaluate images with data analysis tools.

NOTE: Feature values in IDEAS 6.2 and later versions are now being saved in binary format to reduce the file size 
and facilitate faster analysis. Therefore, daf files generated using IDEAS 6.3 cannot be opened using versions before 
IDEAS 6.2. The .daf files created by previous versions of IDEAS may be opened by IDEAS 6.3.  However, if the  files 
are edited and saved, they will no longer be able to be opened by previous versions.
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The Data Analysis Workflow
Data analysis in IDEAS® begins with opening a raw image file (.rif) that was collected and saved using INSPIRE™. Then, 
an existing compensation matrix or a new compensation matrix is applied to the .rif file and two additional files are cre-
ated, the .cif (compensated image file) and .daf (data analysis file).

A compensation matrix performs fluorescence compensation, which removes fluorescence that leaks into other chan-
nels. A compensated image can accurately depict the correct amount of fluorescence in each cell image. Compensation 
is defined as the correction of the fluorescence crosstalk. When creating the .cif the IDEAS application also automatically 
performs corrections to the raw imagery using values saved from the instrument at the time of data collection. These 
corrections include flowspeed normalization, brightfield gains, and spatial registry.

A template is used to define the features, graphs, image display properties and analysis for the .daf.  Within the .daf file, 
the user can perform many analyses using the tools and wizards within the application and save the results as a tem-
plate file (.ast). 

The IDEAS application then calculates feature values and shows the data as specified by the selected template. Once a 
data analysis file (.daf file) or compensated image file (.cif file) is saved, it can be opened directly for data analysis. You 
would only open a .cif if you wanted to change the template or a .rif file to change the compensation. 
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Data File Type Overview
Data from the Luminex® cell analysis systems are collected and managed using three types of data files: raw image file 
(.rif), compensated image file (.cif), and data analysis file (.daf).

This section describes each file type and the table summarizes the features of each file. 

Raw Image File (.rif)
The INSPIRE™ application saves the digital image data, pixel intensities and location that were acquired by the instru-
ment to a .rif file. 

A .rif file contains:

 l Pixel intensity data (counts and location)  collected for each object that the instrument detected.
 l Instrument settings that were used for data collection.
 l Calibration values from ASSIST.
 l Compensation matrix if used while acquiring  data.

Compensated Image File (.cif)
The IDEAS® application creates a .cif file when the user opens a .rif file and applies a compensation matrix. The seg-
mentation algorithm automatically defines the boundaries of each object, creating a mask that is used for calculating fea-
ture values. The applied compensation matrix performs pixel-by-pixel fluorescence compensation prior to segmentation. 
During the creation of the .cif file, the application makes corrections to the imagery. These corrections include:

 l Removal of artifacts from variability in the flow speed, camera background, and brightfield gains. 
 l Alignment of the objects to sub-pixel accuracy, which allows the viewing of compensated imagery, composite 

imagery and the calculation of multi-image feature values, such as the Internalization value.
 l Coincident objects are cut apart to place into individual image frames. Note that this will increase the number 

of objects in the file.

Multiple .cif files can be created from a single .rif file by applying a different fluorescence compensation matrix or cor-
rection each time a .rif file is opened and choosing a unique name for the .cif file. Similarly, you can create a new .daf file 
from a single .cif file by creating a new name and applying a different analysis template. 
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Data Analysis File (.daf)
The IDEAS® application creates a .daf file while it is loading a .cif file into a template file (.ast). The .daf file is the inter-
face to visualize and analyze the imagery that the .cif file contains and must reside in the same directory as the cor-
responding .cif file. 

The .daf file contains:

 l Feature definitions

 l Population definitions 

 l Calculated feature values 

 l Image display settings 

 l Definitions for graphs and statistics 

 l Feature definitions

 l Population definitions 

 l Calculated feature values 

 l Image display settings 

 l Definitions for graphs and statistics 

Loading a .daf file restores the application to the same state it was in when the file was saved, i.e., with the same views, 
graphs, and populations. In IDEAS versions 3.0 or later, a .daf file may be used as a template. 

NOTE: When a .daf file is opened, the .cif file must be located in the same directory as the .daf file since the .daf file 
points to images used for analysis that are stored in the associated .cif file.

Template (.ast)
The IDEAS® application saves the set of instructions for an analysis session in a .daf file to a template (.ast file). Note 
that a template contains no data; it simply contains the structure for the analysis. This structure includes definitions for:

 l Features
 l Graphs 
 l Regions
 l Populations 

The .ast file also contains settings for:

 l Image viewing
 l Image names
 l Statistics

The \templates subdirectory (under the directory where the IDEAS application was installed) contains the default 
template, named defaulttemplate.ast. Because a template is required for loading a .cif file, you must use the default tem-
plate to create the first .daf file. After you save a custom template, you can use it for any subsequent loads of .cif files.

NOTE: The default template may change between releases of the IDEAS application software. In IDEAS versions 3.0 
or later, a .daf file may be used as a template. The default template contains over 200 calculated features per object. 
An expanded template is also available that includes over 600 calculated features per object.
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Compensation Matrix File (.ctm)
The IDEAS® application saves the compensation values that are created and saved during the spectral compensation of 
control files to a compensation matrix file (.ctm file). This file has no associated object data; it is created and saved to be 
applied to experimental files. The compensation matrix can be created in IDEAS using single color control files after 
acquisition or during acquisition. Refer to the INSPIRE™ or FlowSight® user manual for more information.
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Data File Types
NOTE: Even though Windows® does not treat file names as case sensitive, the IDEAS® application depends on the 
case-sensitive .rif, .cif, and .daf file name extensions to identify the file types. Avoid the use of illegal characters for 
file names such as: “\/:*?<>!”.

Table 1. Review of Data File Types

File Type                     
File 

Creatio-
n                     

Description

.rif (Raw Image File)

Created 
in 
INSPIRE
™

Contains instrument setup data, pixel intensity data, and uncorrected 
image data from the INSPIRE™ application. The IDEAS® application 
uses the .rif file to create a compensated image file (.cif file).

.cif (Compensated 
Image File)

User cre-
ates a 
.cif from 
the .rif 
and .ctm

Contains imagery that has been corrected for variations in the camera 
background, camera gains, flow speed, and vertical and horizontal pos-
itioning between channels.

Serves as a database of images used for feature-value calculations 
and imagery display. 

The IDEAS® application also performs fluorescence compensation, if 
necessary, when creating a .cif file. 

The IDEAS® application loads the .cif file into a template to create a 
data analysis file (.daf file)

.daf (Data Anlaysis 
File)

Refer-
ences 
the .cif

The main working data file that contains the calculated feature values, 
the graphs, and the statistics used for analysis. The .daf file references 
the .cif. 

.ast (Template File)
Created 
from the 
.daf

This file contains no data; it contains the structure for the analysis, 
such as, definitions for features, graphs, regions, and populations; 
image viewing settings; image names; and statistics settings.
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File Type                     
File 

Creatio-
n                     

Description

.ctm (Compensation 
Matrix File)

User cre-
ates 
new 
.ctm 
when 
opening 
a .rif or 
during 
acquis-
ition

Contains compensation values that are created and saved during the 
spectral compensation of control .rif files. This file has no associated 
object data; it is created and saved to be applied to experimental .rif 
files.
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Chapter 3: Getting Started with IDEAS®

This chapter is divided into two sections.  The first section contains guided analysis described using the analysis wizards. 
The second section contains advanced analysis, with more detailed instructions  that describe how to open, compensate, 
merge, save, and create data files without using the wizards.  Building blocks are also discussed, which provide a shortcut 
method to building commonly used graphs.

Guided analysis makes it easy to start analyzing your data. Once you are familiar with the basic analysis, available you 
may want to perform more advanced analysis.

Data Analysis Process Overview
NOTE: These steps apply to any type of data analysis whether you use a wizard or not.
1.   Open one data file (the + or - control).
2.    Create and save a compensation matrix for the experiment.
3.    Using an application wizard or the begin analysis wizard:

 l Select focused cells.
 l Select single cells (or conjugates).
 l Select channels for sub-population markers and gate to define sub-populations.
 l Gate on positive cells for the channels you wish to use for morphological analysis.

4.    By using an application wizard evaluate the feature for your analysis and refine as needed. Or follow the feature 
finder wizard to find the feature that separates your populations. Note that if the morphological differences are in 
separate files this may require merging both a  + and - control before beginning step 1.

5.    Refine the analysis and save the template.
6.    Perform batch analysis on all data files in the experiment using the compensation matrix and analysis template.
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Guided Analysis
Data analysis always begins with opening a data file. The Start Analysis button will step you through opening a file, set-
ting the image display mapping and choosing an analysis wizard. Use the Guided Analysis drop-down menu in the 
IDEAS® toolbar to access application wizards, building blocks, and machine learning. 

 
Access application wizards in one of three ways:

 l From the Guided Analysis drop-down menu

 l The wizard icon ( ) on analysis toolbar
 l At the end of the Start Analysis routine

The following wizards are available:
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Application Wizards
Each wizard window is organized so that the instructions for each step are written in the left side of the window, the step-
wise progress through the wizard is shown in the list on the right side and there may be tips provided at the bottom of 
the window. Click Next to progress through the wizard or Exit to stop at any time. Some steps are optional; use the Skip 
button to go to the next step. Follow the instructions in the wizard to complete an analysis. 
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Use the Open File Wizard
This wizard will guide you through the opening of a data file and setting the image display mapping. Use this wizard to 
open a file if you are not using one of the application specific wizards.

1.   Double-click the Start Analysis button. 
2.    Select the data file to open. Click on the folder and navigate to the file you wish to open.

NOTE: You can limit the view to specific file types (.daf, .cif or .rif) by using the drop-down menu ‘Files of type:’ in 
the Select Data File window.

A .daf file will open directly without further input, a .cif file will require a template and a .rif file will require a template 
and a compensation matrix. If the template or compensation matrix boxes are left blank, the default template and/or 
matrix will be appliedFor more information, see Use the Open File Wizard.

3.    Apply compensation. This step occurs when opening a .rif. Choose a compensation matrix or create one.  Click Next.
4.    Apply analysis template. This step occurs when opening a .rif or .cif. Choose a template file if one exists or leave 

blank to use the default template. Click Next.
5.    Name your files. It is recommended that you keep the default names.
6.    Select a wizard to begin analysis. Select a wizard to begin analysis or manually create your analysis template.

NOTE: Every wizard begins the same with set of graphs for choosing focused, single, positive events. The specific 
application wizards will also create special features and or masks specific to the application.
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Use the Display Properties Wizard
This wizard is automatically run when you use the other analysis wizards or the Open File wizard. It is also available to 
run in any open data file from the Guided Analysis menu or from the wizard icon. This wizard will set the image display 
mapping for the channel images you select and create a view of selected images. Brightfield and scatter images will be 
automatically selected.  

1.   Select Wizards from the Guided Analysis menu or click the Wizard icon ( ) in the analysis area toolbar. The Wiz-
ards window opens.

2.    Double-click on the Display Properties option and follow the instructions.

The Display Properties wizard adjusts the mapping of the pixel intensities to the display range for optimizing the display 
and creates a view that includes the chosen channels. This is for display only and does not effect the pixel valuesFor more 
information, see Set the Image Gallery Properties. 
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Use the Begin Analysis Wizard
This wizard is available once a data file is open and will guide you through choosing the focused cells, then single cells, 
then choosing subsets of fluorescent positive cells for phenotypic analysis before progressing on to a morphological ana-
lysis.

The wizards selection screen will display once the data file is open. If you have an open data file and want to access this 
wizard, choose Wizards from the Guided Analysis menu or click on the wand tool.

1.   Gate cells in best focus. A histogram of the brightfield channel Gradient RMS values for the 'All' population  has 
been added to the analysis area. Click on the bins in the histogram to view the images in each bin. The cells with bet-
ter focus have higher Gradient RMS, values. Begin your region at the bin after the Gradient RMS value you wish to 
exclude and continue the region to the maximum in the plot. You may choose an already existing population.

2.    Gate single cells. A scatter plot of the brightfield Area versus Aspect Ratio for the population chosen in step one has 
been added to the analysis area. Single cells will have an intermediate Area value and a high Aspect Ratio. Click on 
the dots to view the image associated with that dot. Note that the image is surrounded by a light green line and the 
image next to it in the image gallery is not its neighbor in the plot. The images are presented in the order defined by 
the drop-down menu above the image gallery.You may choose an already existing population.

3.    Select sub-population marker(s). Choose one or two channels you wish to use to identify populations based on 
Intensity. Click Next to add the scatter plot to the analysis area. Click Skip if you do not wish to use this step. Draw 
regions in the scatter plot to identify as many populations as you want. This step will be repeated until you choose 
Skip or Finish. 

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area, and a statistics 
definition is added to the template. To view the definition, choose Define Statistics Report from the Reports menu.
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Use the Feature Finder Wizard
The feature finder wizard will guide you through the process of choosing a feature for morphological analysis when a 
specific application wizard is not appropriate. This wizard is available once a data file is open; it will guide you through 
choosing the focused cells, then single cells, then choosing subsets of fluorescent positive cells for phenotypic analysis, 
then choosing a feature for morphological analysis.

Open a data file that contains images of both phenotypes you wish to separate.

NOTE: It may be necessary to merge two files together if the populations are in separate files. 
1.   Open the Wizards screen. A data file must be open to access the Feature Finder Wizard.

a.   To open a data file, click the Start Analysis button or select Guided Analysis > Wizards from the IDEAS® tool-
bar. The Wizards screen appears once the data file is open.

b.   To access the Wizards screen when a data file is already open in IDEAS, select Guided Analysis > Wizards, or 
click the wand icon.

2.    Double-click on Feature Finder icon in the Wizards screen to begin the Feature Finder Wizard:

3.    Gate cells in best focus. A histogram of the brightfield channel Gradient RMS values for the 'All' population  has 
been added to the analysis area. Click on the bins in the histogram to view the images in each bin. The cells with bet-
ter focus have higher Gradient RMS, values. Begin your region at the bin after the Gradient RMS value you wish to 
exclude and continue the region to the maximum in the plot. You may choose an already existing population. Click 
Next.

4.    Gate single cells. A scatter plot of the brightfield Area versus Aspect Ratio for the population chosen in step one has 
been added to the analysis area. Single cells will have an intermediate Area value and a high Aspect Ratio. Click on 
the dots to view the image associated with that dot. Note that the image is surrounded by a light green line and the 
image next to it in the image gallery is not its neighbor in the plot. The images are presented in the order defined by 
the drop-down menu above the image gallery.You may choose an already existing population.Click Next.

5.    Select sub-population marker(s). Choose one or two channels you wish to use to identify populations based on 
Intensity and include the channel(s) you are going to use for morphological analysis. Click Next to add the scatter 
plot to the analysis area. Click Skip if you do not wish to use this step. Draw regions in the scatter plot to identify as 
many populations as you want. This step will be repeated until you choose Skip or Finish.

6.    Assign truth populations. Choose two truth populations of cells that represent one morphological phenotype dif-
ference you wish to separate. Use the tagging tool icon to hand-tag images or select pre-existing gated pop-
ulations. Note: If there are more than one phenotypic differences,  repeat the process for each with new truth 
populations.

7.    Select channels and feature categories. Choose the channel and feature category you wish to explore. Multiple 
rows may be entered. The features in the table below will be created and calculated. All of the default features, 
newly created features and user defined features in the chosen categories will be evaluated for their ability to sep-
arate  the truth populations. The three highest ranking features for each category will be saved and available for 
evaluation.
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8.    Results. The top ranking features are listed in the table with their category and channel. A Statistics table is added 
to the analysis area that lists the features with the RD Mean for the truth populations. RD is the Fischer's dis-
criminant ratio which is the difference in the means divided by the sum of the standard deviations for the two pop-
ulations. The larger the RD value, the better the separation afforded by the feature. A scatter plot is added to the 
analysis area of the truth populations for the top two features. 

It may be necessary to refine your results. Visually verify the morphology and separation for the features listed. Addi-
tional features may be quickly plotted by selecting them in the list and clicking 'Plot Features'. To return to the truth pop-
ulation assignment step click 'Refine populations'. To choose different channels or categories click 'Change Category'.

You may also wish to manually make new masks and features using these masks if they are not in one of the Additional 
Features tables.

Table 2. Additional Location Features 

Location features are X,Y pixel coordinates from an origin in the upper left corner, pixels or contour.

Feature Name Description Mask Used

Centroid Features The distance between the Centroids of the intensity weighted 
and non-intensity weighted image Channel Mask

Table 3. Additional Shape Features

Shape features define the mask shape and have units that vary with the feature.

Feature Name Description Mask Used

Aspect Ratio Feature The ratio of the Minor Axis divided by the Major Axis. Object

Circularity Feature The degree of the mask’s deviation from a circle. Object

Density Feature Describes the density of intensities within the object. Object

Elongatedness Feature The ratio of the Height/Width which use the bounding box. Object

Lobe Count Feature The number of lobes in a cell. For more information, see Sym-
metry 2, 3, 4 Features. Object

Shape Ratio Feature The ratio of Thickness Min/Length features. Object

Symmetry 2, 3, 4 Features
These three features measure the tendency of the object to 
have a single axis of elongation, a three-fold and a four-fold 
variation of the shapes. See also Lobe Count Feature.

Object
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Table 4. Additional Size-Based Features

Size-based features are in microns.

Feature Name Description Mask Used

Height Feature
Based on a bounding rectangle, the Width is the smal-
ler side and the Height is the longer side of the rect-
angle.

Object

Length Feature Measures the longest part of the mask. Object

Major Axis and Minor Axis 
Features

Describes the widest part of the mask and the nar-
rowest part of the mask, respectively. Object

Perimeter Feature Describes circumference of the mask. Object,
Threshold 30,50,70%

Thickness Max Feature Describes the longest width of the mask. Object

Thickness Min Feature Describes the shortest width of the mask. Object

Width Feature
Based on a bounding rectangle, the Width is the smal-
ler side and the Height is the longer side of the rect-
angle.

Object

Table 5. Additional Texture Features

Texture features measure pixel or regional variation and indicate the granularity or complexity of the image. 

Feature Name Description Mask Used

Contrast Feature Enumerates changes of pixel values in the image to 
measure the focus quality of an image. Morphology, Object

H Texture Features Measures Haralick texture features. Granularity set-
tings 1,5,15,19 Channel Mask

Modulation Feature Measures the intensity range of an image, normalized 
between 0 and 1. Morphology, Object

Spot Count Feature Enumerates the number of spots. Channel Mask

Std Dev Feature Describes the overall distribution of pixel intensities. Morphology, Object
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Table 6. Additional Signal Strength Features

Signal Strength Features are measured in pixel values.

Feature Name Description Mask Used

Intensity Feature The sum of the pixel intensities in the mask, back-
ground subtracted.

Morphology, Object, 
Threshold 30,50,70 %

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area, and a statistics 
definition is added to the template. To view the definition, choose Define Statistics Report from the Reports menu.
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Use the Apoptosis Wizard
The Apoptosis wizard will guide you through the process of creating the features and graphs to measure apoptosis 
using the images of the nuclear dye and brightfield. Begin by opening a data file, then choosing the Apoptosis wizard.

1.   Select the nuclear image channel: From the drop-down menu, pick the nuclear channel image.
2.    Gate cells in best focus: A Gradient RMS histogram of the All population has been added to the analysis area. Click 

on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 
values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 
maximum in the plot. You may choose an already existing population.

3.    Gate single cells: A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 
have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 
dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not its 
neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-
lery.

4.    Optional. Answer Yes if you want to define sub-populations in your experiment.
5.    Select sub-population marker(s):Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 
step. 

6.    Gate sub-populations: Draw regions in the scatter plot or histogram to identify as many populations as you want. 
This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    (Optional) Select additional sub-population marker(s) OR gate nucleated cells: A histogram of the nuclear channel 
Intensity is added to the analysis area. Gate on the positive events.
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8.    Gate apoptotic cells. The nucleated cells scatter plot of the brightfield Contrast versus the Area of the thresholded 
nucleus is added to the analysis area. Gate on the apoptotic cells with low nuclear area and high brightfield con-
trast.          

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area, and a statistics 
definition is added to the template. To view the definition, choose Define Statistics Report from the Reports menu.
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Use the Cell Cycle - Mitosis Wizard
The Cell Cycle - Mitosis wizard will guide you through the process of creating the features and graphs to analyze the cell 
cycle and identify mitotic events using the images of a nuclear dye.

1.   Select the nuclear image channel: From the drop-down menu, pick the nuclear channel image.
2.    Gate cells in best focus: A Gradient RMS histogram of the All population has been added to the analysis area. Click 

on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 
values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 
maximum in the plot. You may choose an already existing population.

3.    Gate single cells: A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 
have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 
dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not its 
neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-
lery.

4.    Optional: Answer Yes if you want to define sub-populations in your experiment.
5.    Select sub-population marker(s): Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 
step. 

6.    Gate sub-populations: Draw regions in the scatter plot or histogram to identify as many populations as you want. 
This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    (Optional) Select additional sub-population marker(s) OR. Gate G2/M cells: A histogram of the nuclear channel 
Intensity is added to the analysis area. Gate on the G2/M population with 2n DNA.

8.    Gate cells with condensed DNA: The G2/M cells scatter plot of the threshold Area  versus Bright Detail Intensity of 
the nuclear image is added to the analysis area. Gate on the cells with condensed nuclear that have low nuclear 
area and high Bright Detail Intensity values These will include apoptotic cells which you can remove in the next step.

9.    Gate mitotic cells: The condensed DNA cells scatter plot of the brightfield Contrast versus the Area of the threshol-
ded nucleus is added to the analysis area. Gate on mitotic events with low brightfield Contrast.
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The final 3 plots are shown below:

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area, and a statistics 
definition is added to the template. To view the definition, choose Define Statistics Report from the Reports menu.
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Use the Co-Localization Wizard
The co-localization wizard will guide you through the process of creating the features and graphs to measure the co-loc-
alization of two probes with punctate staining in any population of cells you identify. 

1.   Select the co-localization image channels: From the drop-down menus pick the two image channels that contain the 
co-localizing probes.

2.    Gate cells in best focus: A Gradient RMS histogram of the All population has been added to the analysis area. Click 
on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 
values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 
maximum in the plot. You may choose an already existing population.

3.    Gate single cells: A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 
have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 
dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not its 
neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-
lery.

4.    (Optional) Answer Yes if you want to define sub-populations in your experiment.
5.    Select sub-population marker(s): Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 
step. 

6.    Gate sub-populations: Draw regions in the scatter plot or histogram to identify as many populations as you want. 
This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    Gate double positives: A scatter plot of the last gated (or selected) population of the Intensity values for the co-loc-
alization channels is added to the analysis area. Draw a region around the double positive cells for the co-localizing 
probes.
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8.    Gate co-localized events. A histogram of Bright Detail Similarity R3 for the double positive population is added to 
the analysis area. Draw a region to gate on co-localized events. 

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area, and a statistics 
definition is added to the template. To view the definition, choose Define Statistics Report from the Reports menu.

For Research Use Only. Not for use in diagnostic procedures. 31

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



Use the Internalization Wizard
This wizard will create an analysis template for measuring the internalization of a probe in any population of cells you 
identify. 

1.   Select the internalization image channels: From the drop-down menus pick the cell image, the channel that defines 
the cell surface, and the internalizing probe channel.

2.    Gate cells in best focus: A Gradient RMS histogram of the All population has been added to the analysis area. Click 
on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS 
values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 
maximum in the plot. You may choose an already existing population.

3.    Gate single cells: A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 
have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 
dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not its 
neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-
lery.

4.    (Optional) Answer Yes if you want to define sub-populations in your experiment.
5.    Select sub-population marker(s): Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 
step. 

6.    Gate sub-populations: Draw regions in the scatter plot or histogram to identify as many populations as you want. 
This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    Next Step. Optional - Select additional sub-population marker(s) OR gate internalization positives. A scatter plot of 
Max Pixel versus Intensity for the internalizing probe is added to the analysis area. Draw a region to include the pos-
itive cells.

For Research Use Only. Not for use in diagnostic procedures. 32

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



8.    Gate internalization events. A histogram of the Internalization feature for the positive cells is added to the analysis 
area. Draw a region to include the cells with high internalization. The example below shows the internalization of 
labeled CpG (red).

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area, and a statistics 
definition is added to the template. To view the definition, choose Define Statistics Report from the Reports menu.
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Use the Nuclear Localization Wizard
This wizard will create an analysis template for measuring the nuclear localization of a probe in any population of cells 
you identify. 

To begin, double-click on Nuclear Localization:

1.   Step 1. Select the translocation image channels: From the drop-down menus pick the nuclear image channel and the 
translocating probe image channel.

2.    Gate cells in best focus: A Gradient RMS histogram of the All population has been added to the analysis area. Click 
on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 
values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 
maximum in the plot. You may choose an already existing population.

3.    Gate single cells: A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 
have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 
dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not its 
neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-
lery.

4.    (Optional) Answer Yes if you want to define sub-populations in your experiment.
5.    Select sub-population marker(s): Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 
step. 

6.    Gate sub-populations: Draw regions in the scatter plot or histogram to identify as many populations as you want. 
This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    Next Step. Gate double positives: A scatter plot of the last gated (or selected) population of the Intensity values for 
the nuclear image and the translocating probe image is added to the analysis area. Draw a region around the 
double positive cells.

8.    Next Step. Gate translocated events: A histogram of Similarity of the double positive cells is added to the analysis 
area. Draw a region to include the cells with translocation. Note that for a normally distributed population you may 
want to report the RD of the double positive population in a treated versus untreated sample instead of the per-
centage gated.
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Nuclear localization of a probe is measured using the Similarity feature in the final graph presented in the wizard. The 
example shown here is of THP1 cells stimulated with 1 ug LPS for 90 minutes and stained with DRAQ5 (red) and NFkB 
(green) to measure the nuclear localization of the NFkB.

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area, and a statistics 
definition is added to the template. To view the definition, choose Define Statistics Report from the Reports menu.
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Use the Shape Change Wizard
This wizard will create an analysis template for measuring the shape (circularity) of  any population of cells you identify. 

To begin, double-click on Shape Change.

1.   Step 1. Select the cell morphology image channel: From the drop-down menu pick the  channel for the cell image.
2.    Gate cells in best focus: A Gradient RMS histogram of the All population has been added to the analysis area. Click 

on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 
values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 
maximum in the plot. You may choose an already existing population.

3.    Gate single cells: A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 
have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 
dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not its 
neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-
lery.

4.    (Optional) Answer Yes if you want to define sub-populations in your experiment.
5.    Select sub-population marker(s): Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 
step. 

6.    Gate sub-populations: Draw regions in the scatter plot or histogram to identify as many populations as you want. 
This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    Next Step. Gate fluorescence positives: A histogram of the last gated (or selected) population of the Intensity value 
for the cell image is added to the analysis area. Draw a region around the double positive cells. 

NOTE: This step is skipped if the cell image channel chosen is brightfield.

8.    Next Step. Gate shape-changed events: A histogram of Circularity of the last gated population is added to the ana-
lysis area. Draw a region to include the cells with low circularity scores.
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Shape change is measured in the final graph presented in the wizard. Cells with low circularity scores have a highly vari-
able radius. In this example monocytes in whole blood were stained with CD14 (green). 

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area, and a statistics 
definition is added to the template. To view the definition, choose Define Statistics Report from the Reports menu.
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Use the Spot Wizard
This wizard will create an analysis template for measuring texture based on spot counting. If the low and high spot count 
data are in separate data files merge the files together before beginning.

To begin, double-click on Spot:

1.   Gate cells in best focus: A Gradient RMS histogram of the All population has been added to the analysis area. Click 
on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 
values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 
maximum in the plot. You may choose an already existing population.

2.    Gate single cells: A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 
have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 
dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not its 
neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-
lery.

3.    (Optional) Answer Yes if you want to define sub-populations in your experiment.
4.    Select sub-population marker(s): Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 
step. 

5.    Gate sub-populations:The step number sequence is dependent on the number of times the sub-population marker 
step is taken. Draw regions in the scatter plot or histogram to identify as many populations as you want. This step 
will be repeated until you choose Skip.

6.    Select the spot image channel: From the drop-down menu, choose the image channel for the spot counting.
7.    Assign truth populations: From the drop-down menus, select two truth populations, one with high and one with low 

spot count. To create the truth populations, either use the tagging tools or gate the cells of interest.
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8.    Gate spot events. A histogram of the Spot Count feature for the last gated population is added to the analysis area. 
Regions have been drawn that include the truth populations. Adjust the regions as necessary. Note that you may 
want to adjust your truth populations and repeat the wizard after looking at the images and validating the spot 
counts.

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area, and a statistics 
definition is added to the template. To view the definition, choose Define Statistics Report from the Reports menu.

Use Building Blocks
Building blocks may be used to create a graph for finding single cells, focused cells or positive cells based on Intensity. 
The building blocks are shortcuts to creating a graph that provides a limited list of relevant features with set X and Y axis 
scales  for the graph.

Table 7. Building Blocks and Graph Features

Building Block X-Axis Features Y-Axis Features

Fluorescence Positives - one color Intensity_MC_ChX 
(for all channels) n/a

Fluorescence Positives - two color Intensity_MC_ChX 
(for all channels)

Intensity_MC_ChX 
(for all channels)
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Building Block X-Axis Features Y-Axis Features

Focus

Gradient RMS_MX_ChX
(for all channels)

NOTE: Gradient RMS of 
brightfield is the default

n/a

Single Cell

Area_brightfield (default)
Area_scatter
Intensity_MC_ChX 
(for all channels)

Aspect Ratio_brightfield 
(default)
Aspect Ratio Intensity_MX_
ChX
(for all fluorescence chan-
nels)
Intensity_scatter

Single Cell Default Area_brightfield Aspect Ratio_brightfield

Size/SSC Area_brightfield Intensity scatter

1.   Select Building Blocks from the Guided Analysis menu, or click on the Building Blocks icon ( ) in the analysis 
area toolbar. The Building Blocks window opens. This window is used to define a graph with a specified set of fea-
tures available, depending on the purpose of the graph.

2.    Choose the specific Building Block from the Select Predefined Building Block drop-down menu.
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3.    Choose the population(s) to graph.

4.    Choose the X Axis Feature and the Y Axis feature, if applicable.

5.    Click OK. The graph is added to the analysis area.

Machine Learning Module for IDEAS®

The machine learning (ML) module for IDEAS® 6.3 creates an experiment-specific feature that will distinguish pop-
ulations based on user input. It is designed to simplify analysis by allowing users to visually create populations, and 
enhance discrimination by allowing users to combine multiple fluorochromes and multiple morphologies into a single 
super-feature. 

The user provides ‘truth’ populations, and the module creates custom ‘classifier features’ based on the Linear Dis-
criminant Analysis ML algorithm. This algorithm identifies images similar to the ‘truth’ populations. In addition to incor-
porating user-defined features already present in the data file, the ML module creates a comprehensive set of additional 
masks and features, which it then ranks and combines with appropriate weights to maximally separate each ‘truth’ pop-
ulation from the others. The output is a series of ‘classifier features’ that are specifically targeted to the desired phen-
otypes, and can be plotted on histograms or bivariate plots. 
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Calculate New Features with the Machine Learning Module
1.   From IDEAS® 6.3, open the data file of interest with the compensation matrix applied.
2.    (Optional) Apply an analysis template if one exists.
3.    From the IDEAS toolbar, select Guided Analysis > Machine Learning...

4.    In Step 1 of the Machine Learning Classifier, either create a new classifier or modify an existing one.

NOTE: If no classifiers exist, you must create one.

a.   Create a new classifier by selecting Create a new classifier... from the Classifier drop-down, entering a name 
for the classifier in the Classifier name field, and clicking Next.

b.   Edit an existing classifier by selecting it from the Classifier drop-down and clicking Next.

5.    In Step 2 of the Machine Learning Classifier, select the base population from the Base population drop-down menu. 

NOTE: The All population will be the only option if no previous analysis template has been applied. If the user has 
applied a template where gating has been performed, other base populations can be selected (for example, single 
cells).
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6.    Select the truth populations of interest to differentiate between. If populations of interest have already been tagged, 
select at least two populations by holding the Ctrl key and clicking on the populations. If populations of interest have 

not been tagged, use the tagging tool ( ) in the lower-left corner to create them.

NOTE: At least 25 images must be tagged for the Machine Learning (ML) module to run. In most cases, larger num-
bers of images provided to the ML module will generate more robust classifier features.

NOTE: Images in all selected populations must be mutually exclusive (one image cannot belong to two pop-
ulations). The ML module will verify this before continuing and will give the following error if it detects non-mutu-
ally exclusive images:

7.    In Step 3 of the Machine Learning Classifier, select categories that will best differentiate between the populations 
of interest. Select all feature categories to create more general classifier features, or select a few categories to cre-
ate more specific classifier features.

8.    (Optional) If you do not want the ML module to compute any additional masks and features, select the checkbox 
next to Calculated / used features in current analysis. 

9.    (Optional) To exclude specific features, select the Select base features to exclude checkbox, then click Choose. The 
Select Base Features to Exclude window appears. Select any features you would like to exclude, then click OK to 
return to the Machine Learning Classifier window.

10.   In Step 4 of the Machine Learning Classifier, select the channels of interest using the checkbox next to the channel 
name.

For Research Use Only. Not for use in diagnostic procedures. 43

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



11.    Click Start to begin classifier feature calculations.

12.   After classifier feature calculations are complete, Step 5 of the Machine Learning Classifier appears. Choose one of 
the following options:

 l To save your work and exit the Machile Learning Classifier, click Finish.

 l To return to Step 2 of the Machine Learning Classifier and edit the settings specified in steps 2 through 4, click 
Edit.

 l To list and edit classifier features, click the Feature Manager button. The Feature Manager window appears, 
alphabetically displaying all the features. Click the Feature Category button to locate classifier features that 
have been created by the ML module. Highlight an individual classifier feature to display a list of all base fea-
tures used in its creation and the weight of each feature. Click Close to return to Step 5 of the Machine Learn-
ing Classifier.

NOTE: All features in IDEAS®, including classifier features, can be viewed in the Feature Manager at any 
time by navigating to the  Analysis tab in IDEAS and selecting Features.
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Advanced Analysis

Open Data Files

View File Name Extensions
When loading a file, the IDEAS® application uses the file name extension to determine the file type. It will be easier for 
you to distinguish raw image files, compensated image files, and data analysis files from each other if Windows Explorer 
does not hide the extensions.

1.   In Windows® Explorer, go to Tools > Folder Options.
2.    Click the View tab, and make sure that the Hide extensions for known file types check box is not selected.
3.    Click OK.

Use the File menu to open, save, and close image and analysis files, and to quit the IDEAS application.  Alternatively, open 
a data file by dragging and dropping it into an open IDEAS window. Multiple data files can be open in one instance of the 
IDEAS application. 

Open a .rif file
A .rif file is opened when there is new data and the IDEAS® application needs to apply corrections. When opening a .rif 
file, the IDEAS application corrects each image for the spatial alignment between channels, camera background nor-
malization, flow speed, and bright field gain normalization. If you want fluorescence compensation to correct for spectral 
overlap, you must create or choose a compensation matrix at this time by using the control files that were collected for a 
particular experiment. If a FlowSight® data file was acquired with a compensation matrix, that matrix will be used by 
default. The application performs the corrections by using calibration information that was saved to the .rif file during 
acquisition. 

NOTE: Alternatively, use the Open File Wizard to open a .rif file.
1.   From the File menu, choose Open , or drag the .rif file into the IDEAS window.
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2.    Select the .rif file in the Select File To Load window.

NOTE: While browsing for the file to open you can limit the type of file shown in the window to .rif files.

3.    To perform fluoresecence compensation, either open a file containing a compensation matrix or create a new com-
pensation matrix.

a.   To open a file containing a compensation matrix, click the folder icon next to Select a compensation matrix. File 
types that may contain a compensation matrix are .ctm, .rif, .cif, and .daf.

NOTE: If you leave this field blank, the default compensation matrix will be used, which does not contain any 
fluorescence corrections. Do not use the default compensation matrix unless you do not want to compensate 
your data. 

b.   To create a new compensation matrix, click New Matrix.
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4.    In the Select a template or data analysis file (.ast, .daf) field, select a template file to load by clicking the folder ixon 
and browsing for the file. 

NOTE: If this field is left blank, the Default template with the basic features, masks, and settings will be used.  
FlowSight® basic files use the acquisition template as the default.

5.    (Optional) Select the Use acquisition analysischeckbox  if you wish to use the acquisition analysis performed on the 
instrument, which includes feature definitions, regions, populations, and analysis area plots.

6.    (Optional) To load a subset of objects or change the .cif and .daf file names to be created, click the Output File 
Options... button. The Output File Options window appears.

                                    
a.   (Optional) Change the name of the .cif and .daf files to be created using the Compensated image file (.cif) and 

Data analysis file (.daf) fields. Luminex® recommends keeping the default names.

b.   (Optional) Choose to load a subset of objects using the Select events to load field. Select Random or Sequential 
to have IDEAS choose objects randomly or sequentially.

NOTE: Select a smaller number than the maximum if you have a large number of objects to load. This helps 
save time for creating a template file. 

For Research Use Only. Not for use in diagnostic procedures. 47

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



a.   (Optional) To view the corrections that will be applied to the .rif file, click the Advanced...  button. The Opening 
file window appears. Make any changes to the corrections that you need, and then click OK

b.   Click OK when you are finished with the Output File Options window.

7.    Click OK. The application creates the .cif and .daf files, and the .daf file is loaded into the Image Analysis area.

NOTE: Most often, the defaults will be adequate. For some older data files, you may need to provide control files 
for certain settings. For assistance, call Luminex Technical Support.

Open a .cif file
A .cif file is generated when corrections are applied to a .rif file. When opening a .cif file, the IDEAS® application cal-
culates feature values and creates a .daf file to display images and graphs.

When opening a .cif file, an analysis template is selected. The template provides the initial characteristics of the analysis. 
Opening the .cif file causes the IDEAS application to calculate feature values and to use populations, graphs, and image 
viewing settings to display the cells as defined by the template.

NOTE: Alternatively, use the Open File Wizard to open a .cif file.
1.   From the File menu, choose Open , or drag the .cif file into the IDEAS window.
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a.   Select the .cif file that you want in the Select File To Load window.

NOTE: While browsing for the file to open, you can limit the type of file shown in the window to .cif.

2.    Select a template or a data analysis file by clicking the folder icon or manually entering the file path in the field. 

NOTE: If this field is left blank, the IDEAS application will use a default template. However, it is useful to create and 
save your own templates for specific experimental procedures. 

3.    Change the Data analysis file name, if necessary. The default name matches the name of the .cif. 
4.    Click OK. During the opening of a .cif file, the IDEAS application calculates the values of the features that are 

defined in the template you selected. The progress is shown by a progress bar. After the application has suc-
cessfully opened the .cif file, the .daf file is saved. 

Open a .daf file
A .daf file contains the calculated feature values so that they will not need to be recalculated.

To open a .daf file, the IDEAS® application requires the .cif file to reside in the same directory. The .daf file does not con-
tain any image data; think of the .cif file as the database that contains the imagery. Because all of the feature values have 
been saved in it, the .daf file should open quickly.

NOTE: Alternatively, use the Open File Wizard to open a .daf file.
1.   From the File menu, choose Open or drag the file into the IDEAS window.
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2.    Select the .daf file that you want in the Select File To Load window.

NOTE: While browsing for the file to open, you can limit the type of file shown in the window to .daf.

The progress is shown by a progress bar. The state of the IDEAS application is restored to what it was when the .daf file 
was saved. 

Save Data Files
Data files are saved at several stages of analysis. Raw image files (.rif) are saved during data acquisition by merging mul-
tiple .rif files or by creating new files from populations. Compensated image files (.cif) and data analysis files (.daf) are 
saved when opening .rif files, merging multiple .cif files, or when running a batch analysis. The IDEAS® application also 
saves other types of files that are used for data correction and presentation. Template files (.ast) save the structure of 
an analysis and compensation matrix files (.ctm) save the compensation matrices. 

Application Defaults are set that direct the files into specific folders and can be viewed or changed by the user.

Save a Data Analysis File (.daf)
A .daf file contains a snapshot of an analysis. Saving the analysis as a .daf file allows you to recall that analysis simply by 
opening the file. When you quit the IDEAS® application, you are always prompted to save changes to a .daf file. You can 
also save changes from the File menu. Remember that the .daf file does not contain image information, so opening the 
.daf file requires the related .cif file to reside in the same directory. 

1.   Select File > Save as Data Analysis File (.daf).

NOTE: To reduce the size of a data analysis file, save the .daf with only the features that are used for analysis of 
statistics or graphs. Click File > Save as Data Analysis File - Used Features Only and continue with the procedure.

2.    Enter a file name. 

NOTE: The default directory is the one where the .cif file was saved.

3.    If you select an existing file name, a warning appears that asks you to verify the overwriting of the existing file. 
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4.    Click Save. The data is now ready for analysis. You can create graphs, view imagery, and display feature values and 
statistics. After you have defined an analytical procedure in the .daf file, you can save the file as a template, which 
allows you to use the procedure for analyzing other files.

Save a Compensated Image File (.cif)
The IDEAS® application creates and saves a .cif file when a .rif file is opened. By default, the application names the .cif 
file with the same name that the .rif file has, replacing the .rif extension with .cif. The application also places the .cif file in 
the same directory as the .rif file. The .cif file will be larger than the .rif file because the .cif file contains masking inform-
ation as well as corrected and/or compensated images.

Save a Template (.ast)
Saving an analysis as a template allows you to apply the structure of the analysis to other .cif files. Save a template file 
after saving a .daf file. A template includes all graph definitions, Image Gallery settings, feature definitions, and statistics 
settings. No data is saved in a template. Therefore, selected images and populations that are dependent on specific 
objects, such as tagged populations, are not saved.

1.   Click File > Save As Template File (.ast). The Save File dialog box appears.
2.    Enter the name of the file to save.
3.    Click Save. If you select an existing file name, a warning appears that asks you to verify the overwriting of the exist-

ing file.             

NOTE: You can change the default template directory by clicking Analysis > Application Defaults.             
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Overview of Compensation
Spectral compensation corrects imagery for fluorescence that leaks into nearby channels so that you may accurately 
depict the correct amount of fluorescence in each cell image. 

For example, the light from one fluorochrome may appear primarily in channel 3, but some of the light from this fluoro-
chrome may appear in channel 4 as well, because the emission spectrum of the probe extends beyond the channel 3 
spectral bandwidth. The light from a second fluorochrome may appear primarily in channel 4 but, unless you subtract 
the light emitted by the first fluorochrome into channel 4, you cannot generate images that accurately represent the dis-
tribution of the second fluorochrome. 

Emission Spectra for two fluorochromes:
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Below is an example of cells stained with four fluorochromes independently and run together as one sample. Intensity 
scatter plots for two fluors and images for the four fluors are shown uncompensated and compensated. Image com-
pensation is performed on a pixel by pixel basis.

The IDEAS® application builds a matrix of compensation values by using one or more control files. A control file contains 
cells stained with one fluorochrome. Because it is critical that matrix values be calculated from intensities derived from a 
sole source of light, control files are collected without brightfield illumination, or scatter. The brightfield compensation is 
performed automatically. The process of creating the compensation matrix is described in the next section.

Create a New Compensation Matrix File
The compensation matrix is a table of coefficients. The IDEAS® application uses this table to place the detected light that 
is displayed in each image into the proper channels, on a pixel-by-pixel basis. The coefficients are normalized to 1. Each 
coefficient represents the normalized amount of the leakage of the fluorochrome into the other channels. Compensation 
is performed during the creation of a .cif file from a .rif file.
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The default matrix, which is used if no compensation matrix is chosen, is the identity matrix, shown below. 

1.   Start the Compensation Wizard in one of two ways:

 l Click the New Matrix button when opening a .rif file 
 l OR select Compensation>Create New Matrix. 

The compensation wizard opens to Step 1: 

l

2.    Add compensation control files by clicking Add Files and browsing for the control files for the experiment. The files 
will have the suffix no-BF. Hold down the control key to select multiple files at once.

NOTE: It is important to collect only single color positive cells or beads to use for compensation files. Collect 500-
1000 positive events for each file. Collecting more events or including negative and very dim cells is not recom-
mended since the compensation calculations expect only positive events.

3.    When all of the control files for the experiment have been added to the list, click Next. The control file(s) are 
merged and loaded. 
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4.    Verify the channels for each control in the experiment by checking the channel boxes.

The following tables are provided as a guide for each instrument configuration. 

Table 8. First generation ImageStream® (IS100)

Ch 1 Ch 2 Ch3 Ch 4 Ch 5 Ch6

470-500nm 400-470nm 500-560nm 560-595nm 595-660nm 660-735nm 

Scatter DAPI FITC PE 7-AAD PE-Cy5

Table 9. ImageStreamX® - 1 camera

Ch 1 Ch 2 Ch3 Ch 4 Ch 5 Ch6

435-505nm 505-560nm 560-595nm 595-642nm 642-745nm 745-780nm 

DAPI FITC PE PE-TexasRed AF647 APC-Cy7

Table 10. ImageStreamX - 2 camera

Ch 1 Ch 2 Ch3 Ch 4 Ch 5 Ch6

435-480nm 480-560nm 560-595nm 595-642nm 642-745nm 745-780nm 

 BF FITC PE PE-TexasRed PE-Cy5 PE-Cy7

Ch 7 Ch 8 Ch9 Ch 10 Ch 11 Ch 12 

435-505nm 505-570nm 570-595nm 595-642nm 642-745nm 745-780nm 

DAPI Pacific Orange BF Texas Red AF647 APC-Cy7

5.    Background and spatial offset corrections are performed, the imagery is displayed, bivariate plots of adjacent chan-
nels Intensity are added to the analysis area and the compensation matrix values are computed and displayed in a 
table.
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Example:

The Positive Control Populations are shown in the graphs below.
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6.    Choose one of two methods for calculating the coefficients. The compensation files are merged and each object is 
scrutinized for it's peak channel emission. For each fluorochrome, the application automatically identifies a positive 
control population, excluding the brightest and dimmest objects, and assigns it to the proper channel.

 l Use the Best Fit method for objects where intensities vary, such as cells. This method is determined by cal-
culating best fit linear regression for each dye into each channel.

 l Use the Means method for objects that have only slight variations in intensity and therefore do not produce a 
linear correlation, such as beads. The means method uses the ratio of the intensity of the spillover channel to 
that of the positive control channel. 

7.    Inspect the matrix values in the table of coefficients. 

NOTE: Coefficients should always be less than 1, and decrease from the assigned channel. In other words, leakage 
should be greater in the channel nearest to the assigned channel. Fluorescence always extends in the long-
wavelength direction from the exciting light. 

8.    Verify that no coefficients are larger than 1.                                     Verify that, in a column corresponding to a fluorochrome, the coef-
ficients decrease from the assigned channel. 

9.    Verify that the coefficient is greater in the channel below the 1 in the table than the value above the 1 in the table. 
10.   Verify that these coefficients also decrease in subsequent channels below the 1. 
11.    Verify that there are no changes from the identity matrix in the columns where there are no fluorochromes, includ-

ing the scatter and brightfield channels. If necessary, the column can be set to the identity values by double-clicking 
on the heading.

12.   Check for coefficients in red text. These coefficients have errors of 1% or more to the best fit line. This means you 
should inspect the graphs for these coefficients and if possible reduce the error by eliminating outliers or choosing 
the population manually. The purpose of making these coefficients red is to point out the coefficients that may need 
attention, but it may be that the error will remain above 1% and remain red. 

13.   Inspect the coefficients in the matrix by double-clicking on the coefficient. A graph representing the coefficient 
appears. The population plotted in the graph is the positive control population of the column of the coefficient. The 
X Axis represents the intensity in the assigned channel of the fluorochrome. The Y Axis represents the intensity in 
the channel of leakage. The coefficent value and error are also displayed.
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You can use the automatically generated control populations as they are, or you can refine them and create different 
populations by using the region tools. By default, the populations are named 3_Positive, 5_Positive, and so on. You can 
view the populations in the Image Gallery. Some populations may be empty. 

 l To choose a different population, use the arrow and select the population from the list. The hierarchical rela-
tionship is shown in the population list. Assign populations only to the channels that correspond to the fluoro-
chromes used in the experiment.

 l If needed, you can create new scatter plots by using the Analysis Area toolbar. For example, a 4_Intensity 
versus 5_Intensity plot may be useful.

 l If you want to clear a column, double click on the channel heading. 

 l The slope of the line on the plot is the coefficient in the matrix.

Optional: Remove Objects from the Population
If objects in the population exist that are outliers, they should most likely be removed from the positive population within 
the compensation matrix by the following these steps:

1.   Within the compensation wizard, double-click the coefficient to display the intensity plot. 

2.    If you notice outliers, click Add Graph to Analysis Area. The plot populates in the Analysis Area.
3.    Return to the Analysis Area and use the region tools to draw a new region on the plot that defines a new positive 

control population, excluding the outliers. 

a.   Create a new region to exclude outliers.

b.   Click the Resize  and Zoom  buttons on the graph toolbar to more clearly see the population of 
interest. Using one of the region buttons on the toolbar, draw a region that contains only the cells you want to 
use for determining compensation. You can click a point on the graph and view the image to help you decide 
where the region boundaries should be. 
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In the example below, the Polygon Region tool was selected to draw a border around a selection of cells. Clicking within 
the graph anchors the line and double-clicking completes the region. 

4.    Assign the new population to the appropriate channel by using the Positive Control Populations list for that channel.

5.    The coefficient value is automatically recalculated when a new population is selelcted.
6.    Repeat these steps as required to redefine the coefficients. 
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7.    Click Preview Images to view individual objects with corrections applied. Double click on an image to add it to the 
preview window. 

NOTE: The corrections are only applied to on-camera channels. For example, if the object is brightest in channel 3 
on the first camera, only channels 1-6 are shown corrected for that object. 

8.    When the matrix appears satisfactory, click Finish.
9.    Enter a name for the compensation matrix file (.ctm) and click Save.

NOTE: The matrix is saved as a compensation matrix file (.ctm file). This file contains the compensation values and 
can be opened later for editing. To provide the values for fluorescence compensation, you select a .ctm file when 
opening a .rif file.
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Compensation Matrix Files

Preview and Edit a Compensation Matrix
A compensation matrix can be applied to a population or .rif file in a preview mode for editing a matrix.

1.   Select View/Edit Compensation Matrix from the Compensation menu to view, edit or preview the matrix on image 
data. Select the data file by clicking on the folder  icon, then clicking Open. The matrix values are displayed in a table 
and may be edited.

2.    To preview the matrix on image data, browse for a file or select a population from the current file to preview and 
click Preview.

Troubleshoot Compensation
Sometimes an applied matrix produces poorly compensated data. This can happen for a number of reasons: 1) mis-
calculation of the compensation matrix by inclusion of inappropriate events (such as doublets, saturated pixel events, or 
artifacts), 2) controls used for matrix calculation differ significantly from the experimental samples (different cell type, 
different probe), or 3) cells exhibit substantial auto-fluorescence. This protocol describes a method for manually adjust-
ing and validating a compensation matrix for difficult samples. 

To troubleshoot and repair a compensation matrix:

1.   Create a population of cells that are miscompensated using the tagging tool. Choose single cells that are exhibiting 
crosstalk. Choose a range of intensities from negative to bright but not saturated, preferably single color. If single 
color cells are not available, choose cells with a distinct staining pattern in the peak channel. 

2.    Create Intensity scatter plots of adjacent channels in order to observe the over- or under-compensation. 
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3.    Identify the matrix values that need adjusting by inspecting the scatter plots and images. Each column contains the 
coefficients for the peak channel into the corresponding crosstalk channels (rows). For example the crosstalk of 
channel 2 (green) into channel 3 is highlighted in the matrix below.

Undercompensation (crosstalk coefficient is too low):

 l Plots: Intensity mean for the single color positive population is higher than the unlabeled population in the 
crosstalk channel or the intensity in the crosstalk channel trends diagonally upwards.

 l Images: the crosstalk channel contains an apparent fluorescent mirror-image.

Overcompensation (crosstalk coefficient is too high):

 l Plots: Intensity mean for the single color positive population is lower than the unlabeled population in the 
crosstalk channel or the intensity in the crosstalk channel trends diagonally downwards.

 l Images: the crosstalk channel contains dark spots corresponding to the bright spots in the fluorescent channel 
of interest.

4.    In the Compensation menu, choose View/Edit Matrix and manually change the incorrect crosstalk matrix values 
identified above. Start with changes of ~.1 or ~.05 and use smaller and smaller increments as you refine the matrix.

5.    Click Preview and choose the tagged population to view the results of the changed coefficient.
6.    Repeat steps 4 and 5 until the matrix is corrected. 
7.    Click Save, append manual to the matrix name, then click OK. 
8.    Open the .rif file and use the new matrix to create a new .daf file. 
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Merge Data Files

Merge Raw Image Files
You can merge .rif files together for analysis.

1.   Click Tools > Merge .rif Files. The Merge Raw Image Files window displays. 

2.    To select the .rif files to merge, click Add Files.
3.    The .rif file names appear in the list.
4.    If you want to remove a file from the list, select it and then click Remove File.
5.    When the merge list is complete, click OK.
6.    The Save Merged Raw Image (.rif) File dialog box appears.
7.    Type a unique file name.
8.    Click Save. The Creating merged .rif file window appears

 

9.    When the merge is complete, the Merged .rif Created message displays.
10.   Click OK.

NOTE: The sample information will contain information for the first file in the merge list. 

NOTE: For ImageStreamX® non-MkII files, the classifier is turned off when a merged file is loaded. To turn the clas-
sifier on manually, go to the Advanced panel on the open .rif window when opening an ImageStreamX non-MkII 
merged file. ImageStreamX MkII and FlowSight® do not use classifiers.

NOTE: When opening a merged .rif file, an easy method for gating the separate files is to create a scatter plot of 
the Object Number versus Time. Each population will fall on a different line.

Merge Compensated Image Files
You can merge .cif files together for analysis.
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1.   Click Tools > Merge .cif Files. The Load Multiple .cif Files window appears.

2.    To select the .cif files to merge, click Add Files. The .cif file names appear in the list.
3.    If you want to remove a file from the list, select it and then click Remove File.
4.    Type a unique name for the output files.
5.    Select a template.
6.    Click OK. The merged files are created and the new .daf file is loaded with a population created from each file.

Create New Data Files

Create New Data Files From Populations
To further analyze a population or merge it with other data when working in a .daf, you can save it to a new data file. 
This  is useful if your data file contains a large number of objects that are not pertinent to your experiment. Decreasing 
the data file size results in better performance by the IDEAS® application.. 

NOTE: You cannot create a new .cif or .rif when multiple data files are open.

For Research Use Only. Not for use in diagnostic procedures. 64

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



1.   Click Tools > Create Data File from Populations.The Create .cif and/or .rif From Populations window displays.

 

2.    In the Select populations list, select the populations that you want to include in the new data file(s). Ctrl click to 
select multiple populations.

3.    To create a .rif file, select the New Raw Image File (.rif) check box, the population name is used as a default. You 
may enter a new name.

4.    To create a .cif file, select the New Compensated Image File (.cif) check box, the population name is used as a 
default. You may enter a new name.

5.    Click OK. If you created a new .cif file, you can choose to load it. When loading the .cif file, the application will 
prompt you for the template. 

View Sample Information
All of the information associated with an IDEAS® file—such as the collection information, camera settings and cor-
rections—is saved  and can be viewed in the Sample Information window.

1.   Go to Tools > Sample Information to open the Sample Information window. Information for the open data file will 
be loaded. 

2.    Browse for a different data file by clicking on the folder icon. You can open the Sample Information Window for any 
of the following file types: .rif, .cif, or .daf.

3.    Select a tab to see the information for each heading.
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4.    Click Print from any tab to print a report of all of the sample information. 

NOTE: You may click on the folder and browse for a file to view the sample information for any file without loading 
the file.

 l Acquisition tab: File names, software version numbers, date acquired, number of objects, sample name.             
 l Corrections tab: Camera background, alignment offsets (from ASSIST).
 l Focus/Fluidics tab: Core information and sample volume.
 l Detection tab:IS100 and ImageStreamX® only: Cell classifier settings during acquisition.
 l Population tab: FlowSight and ImageStreamX MkII only: Lists the populations and number acquired.
 l Camera Settings tab: Bin mode, magnification, gain (2=High Gain), and sensitivity settings.
 l Illumination tab: Brightfield and laser information.
 l EDF tab: View kernels used for deconvolution of EDF imagery.
 l Compensation tab: View the compensation matrix.
 l Channels tab: Lists channels collected.

Batch Processing
Batch processing allows you to automatically analyze a group of files with one template when a compensation matrix 
has already been generated for the experiment.
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1.   On the Tools menu, select Batch Data Files. The Batches window displays. It lists a record of all batches you have 
processed. 

2.    Click Add Batch. The Define a Batch window displays.

3.    To select the files for the batch, click Add Files. Navigate to the files and select by clicking on the file. Select multiple 
files to add by holding down the Ctrl key while selecting the files. 

a.   To remove files from the Files to Process list, click Remove Files.

4.    Select a compensation matrix from a file (.ctm, .cif, or .daf). Compensation is applied to .rif files only.
5.    Select a template file (.ast or .daf). Leave blank to use the Default template or check 'Use acquisition analysis for .rif 

files' if this is desired. 

NOTE: If a template is entered it will over-write the acquisition analysis.

6.    Set the output files options.
7.    If the template contains a statistics report definition, the Preview Statistics Report button will display. Click on Pre-

view Statistics Report to review the report or re-order the files as you wish them to be reported. To reorder the 
files, select a file with a left-click, then right-click in the desired position and select move here.
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8.    (Optional) If you have a large rif file, you may want to segment the file into multiple smaller files.

a.   Click on the Segment .rif Files button.

b.   Choose the segment size. The number of files that will be created is updated depending on the segment 
size chosen and the number of objects in the file as shown in this example. The segmented files will 
include the segment number and size in their names.

c.   Click OK when done.

9.    Click OK in the batch definition window. The Define a Batch window closes. The batch appears in the Batches win-
dow.

The Batches window offers the following options:

 l Add Batch: Creates another batch and adds it to the list.
 l Remove Batch: Removes a batch from the Batches to Run list.
 l Edit Batch: Edits a batch in the Batches to Run list.
 l Submit Batches: Starts the batches to run the process.
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10.   When you are satisfied with the Batches to Run list, click Submit Batches. The files to process are listed and the pro-
gress is displayed in the Processing Batch window. Once you have started processing batches, it may use up a fair 
amount of your computer’s processing power. After a batch is run, it appears in the processed batches list. You 
may get a report or rerun a batch from the list.

NOTE: To cancel the batch processing at any time, click Cancel Batch. The IDEAS® application will confirm can-
cellation and complete the file it is working on. When the batch processing is complete, the IDEAS application 
saves the .rif, .cif, and .daf files in the batch results directory. In the Batches window, a list of processed batches 
appears in the Processed Batches list. If a batch did not successfully complete, it will appear in red. 

NOTE: To display the error that occurred during processing, double-click the batch.
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11.    (Optional) To rerun a batch, highlight the batch name and click Add at the bottom of the window. This will move the 
batch into the run list, where it may be edited.

12.   (Optional) To get a batch report, double-click the batch name, or highlight the batch name and click Details. The 
Batch Results window appears.

a.   In the Batch Results window, click Print.

b.   In the Batch Results window, click Close.

c.   In the Batches window, click Close. 
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Overview of the Data Analysis Tools
The IDEAS® application provides a powerful tool set that allows you to explore and analyze data. The rich feature set lets 
you create hundreds of your own features to differentiate objects and statistically quantify your results.

As shown in the following figure, the application window is divided into two panels— the Image Gallery and Analysis 
Area—which each provide the corresponding tools that you can use for data analysis. The layout can be changed to side 
by side or top and bottom with re-sizable panels.

You can create populations of objects by tagging hand-selected images, drawing regions on graphs, and using Boolean 
logic to combine existing populations.  After you have created a population, you can view it in the Image Gallery or plot it 
on a graph. You can view the statistics for populations or objects in tables placed in the analysis area.
Graphs show data plotted with one or two feature values, and tools are provided that allow you to draw regions for the 
purpose of generating new populations. You can show any population on a plot.

Every image is linked to the feature data. Selecting an individual data point in a graph allows you to view it in the Image 
Gallery or look at its feature values in the Statistics Area. Any object that is selected in the Image Gallery is also shown 
on the plots in the Analysis Area. Images may be ordered in the Image Gallery by feature value.
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Use the Image Gallery
This section describes how to view populations of objects in various ways, view masks, customize the Image Gallery dis-
play, and hand-select objects for a population:

Overview of the Image Gallery
The Image Gallery displays the imagery and masks of any population of objects.

A toolbar is provided in the upper-left corner of the panel, as shown in the following figure. The Image Gallery also 
makes different viewing modes available for the imagery. The default template contains the viewing modes which 
allows you to view all channel images in grayscale or color, or each channel image individually. 

NOTE: You can build custom viewing modes as shown in this example..

Image Gallery Tools

Table 11. Image Gallery Tools

Tool Description

 Tagging Mode Tool Creates a population of hand-picked objects.

 Image Gallery Properties 
Tool

Provides custom display features.

 Show/Hide Mask Tool Displays masks on the imagery.

 Show/Hide Color Tool Sets the Image Gallery color.
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Tool Description

Show/Hide Saturated Pixels 
Tool

Shows any saturated pixels in a contrasting color.

Zoom Tools

Zooms in or out and resets zoom on the Image 
Gallery. 

View Imagery for a Population 
Click the population that you want from the Population drop-down menu of the Image Gallery. The drop-down list 
includes all the populations, as well as the currently selected bin from a histogram.

Select an Individual Image
Click on the image to select it. A thin, green frame indicates the selected object. 

NOTE: Conversely, in any scatter plot in the analysis area, clicking a graphical point causes the Image Gallery to high-
light and display the corresponding object.

 l The object’s feature values are displayed in a table if an object is selected and a table is added to the Analysis 
Area.

 l The selected object is identified in each scatter plot graph with a green cross.
 l The objects are presented in the Image Gallery in  object number order by default. To order the objects by 

another feature choose the feature in the drop-down menu.
 l The image can be placed in the Analysis area by right-clicking and selecting Add Image to Analysis Area.

Change the Order of Images
In the Order by drop-down menu of the Image Gallery, select a feature you wish to order the cells by and choose ascend-
ing or descending values.

NOTE: You can show the feature values on the images when creating the view in the Image Gallery Properties tool.

Change the Viewing Mode
In the View drop-down menu of the Image Gallery, select a specific view. The imagery display changes according to the 
new view. To make a new view, use the Image Properties tool.
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Show or Hide Masks

Click the Show/Hide Masks toolbar button ( ) to toggle between showing and hiding the selected masks for all 
images in the Image Gallery.

The mask is shown as a transparent layer over each image. The mask displayed is selected in the Image Gallery Prop-
erties View tab. The color of the overlayed mask can be changed in the Applications Defaults under the Options menu.

NOTE: To hide the mask for a specific channel only, set the individual channel mask to None in the view tab of the 
Image Properties dialog.

Show or Hide Color

Click the Show/Hide Color toolbar button ( ) to toggle between showing and hiding the colors for all images in the 
Image Gallery. 

Zoom on the Image Gallery
Click the Zoom In toolbar button to view the images in the gallery closer and the Zoom Out or Reset Zoom to reverse the 
zoom.

Show or Hide Saturation

Click the Show/Hide Saturated Pixels toolbar button ( ). Saturated pixels in images, if any, appear in a contrasting 
color. 

 

Show the Mask or Feature Being Used for the Current View
Hover over the channel name. The mask or feature being used for this view is displayed.
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Set the Image Gallery Properties
When a new data file opens in the default template, you might find it difficult to clearly see cell morphology because the 
Image Gallery display properties have not yet been properly adjusted for the data set. To optimize the display, use the 
wizard  to set the pixel intensity mapping to the display range. 

Clicking the Image Gallery Properties toolbar button ( ) opens the Image Gallery Properties window, which contains 
the following tabs:

 l Display Properties—Define the name, color, and display intensity mapping for each image. Allows adjustment 
of the image size for the image gallery.

 l Views—Customize the views for the Image Gallery. 
 l Composites—Create composites and adjust the amount of color from a channel that is included in a composite 

image.

Customize the Image Gallery Display Properties

Click the Image Gallery Properties toolbar button ( ) to begin. The Image Gallery Properties window appears with the 
Display Properties tab displayed. 

Change the Size of the Panels in the Image Gallery
Display Width and Display Height can be specified or changed to Auto Fit in the lower left section of the Display Prop-
erties tab.

Change the Name or Color for Each Image
1.   Select an image in the list of images on the Display Properties tab of the Image Gallery Properties window. 
2.    On the right side of the window, you can type a new, unique name for the selected image. 

NOTE: Each image is provided with a default name and the image names appear near the top of the Image Gallery.
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3.    Click the colored square for the selected image. 
4.    Click the color that you want in the color palette.
5.    Click OK to close the palette.

NOTE: The grayscale image in each channel is assigned a default color for image display in the gallery. Setting the 
color to white is equivalent to using the original grayscale image. The colors are also used to build composite 
images.

Fine-Tune the Image Display Intensity for an Image
1.   On the Display Properties tab of the Image Gallery Properties window, select an image by clicking the image name 

in the list. The graph for the currently selected image is shown in the window and updates as the changes are 
made. Select an image in the image gallery that has intensities for the image channel you are adjusting.

NOTE: You will adjust the Display Intensity settings on the graph (the Y Axis), the value of the display to (the X 
axis), the range of pixel intensities. The range of pixel intensities will depend on the instrument and the collection 
mode set during acquisition. The display range is 0–255; the range of intensities from the camera is 0-4095 for the 
ImageStreamX® or 0-32,767 for EDF mode collection. The IS100 first generation instrument has a 10 bit camera 
and therefore the range of pixel intensities is  0–1023. The limits of the graph enable you to use the full dynamic 
range of the display to map the pixel intensities of the image.

 l At each intensity on the X Axis of the graph, the gray histogram shows the number of pixels in the image. This 
histogram provides you with a general sense of the range of pixel intensities in the image. The dotted green 
line maps the pixel intensities to the display intensities, which are in the 0–255 range.

 l Manual setting is done by click-dragging the vertical green line on the left side (crossing the X Axis at 0) allows 
you to set the display pixel intensity to 0 for all intensities that appear to the left of that line. Doing so removes 
background noise from the image.

 l Click-dragging the vertical green line on the right side allows you to set the display pixel intensity to 255 for all 
intensities that appear to the right of that line.

2.    From the Image Gallery window, select the object to use for setting the mapping. It appears in the Image Gallery 
Properties window. 

NOTE: You might need to select different objects for different channels because an object might not fluoresce in all 
channels.
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3.    To adjust the pixel mapping for display, click-drag the vertical green line by clicking near it (but not near the yellow 
cross). 

NOTE: For fluorescence channels, set the vertical green line that appears on the left side to the right of the large 
peak of background pixel intensities as shown above and set the right vertical green line to the right of the brightest 
pixel intensities. Click 'Set Linear Curve' to make the transformation linear. For the brightfield channel, set the ver-
tical lines to about 50 counts to the right and left of the histogram to produce an image with crisp brightfield con-
trast.

 l To change the mapping curve to be logarithmic or exponential, click-drag the yellow cross.
 l To restore the mapping to a linear curve, Click Set Linear Curve.
 l To see the full scale for the X Axis Click Full Scale.
 l To set the display mapping of the X Axis to the lowest and highest values for a selected object, Click Set Range 

to Pixel Data.
 l To set the scale of the X Axis to the range of the vertical green lines or of all the pixel intensities for the selec-

ted object—whichever is larger—Click Autoscale.
 l You may enter values manually by selecting the Manual tab.

4.    If you want to preview the changes in the Image Gallery, click Preview Changes in Gallery.
5.    Continue customizing the Image Gallery display properties with another procedure in this section, or click OK to fin-

ish and save changes or Cancel to finish and discard changes.
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Customize the Image Gallery Views, Images, and Masks
1.   Within the Image Gallery Properties window, click the Views tab.

NOTE: The Image Gallery view can be customized to view any combination of channel images or composites. The 
default view All Channels is a view that displays all image channels that were included during acquisition of the file 
with their associated default masks. This mask may be changed for the default view however, the images in this 
view cannot be changed. The list of existing views is shown on the left.

2.    To create a new view, Click New. The new view is automatically added to the list on the left.
3.    In the right section of the window, type in a name for the view.
4.    Click Add Column.
5.    Define the column by selecting an image and a mask or a composite from the drop-down menu.
6.    To show a feature value on an image check the box and choose the  feature.
7.    Repeat the previous 2 steps until finished adding columns to the view. A column will be added under the column cur-

rently selected. To insert a column click on the image above insertion point.
8.    Columns may be removed by clicking on Remove Column.
9.    A view may be edited at any time by selecting the view and following the same procedures. 
10.   If you want to delete a view, click the view to select it, and then click Delete.

A confirmation window appears. 
11.    If you want to preview any new changes in the Image Gallery, return to the Image Gallery and choose your new 

view in the View drop-down menu. Then return to the Image Gallery Properties window and click Preview Changes 
in Gallery.

12.   Continue customizing the Image Gallery display properties with another procedure in this section, or click OK to fin-
ish and save changes or Cancel to finish and discard changes.
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Create a Composite
1.   Within the Image Gallery Properties window, click the Composites tab. The list of existing composites is shown on 

the left.

2.    In the right section of the window, type a name for the composite or leave blank to allow the name to be built auto-
matically from the image names added to the composite.

3.    Click Add Image. The selected image appears in the Object box. Change the Percent if desired. The percent spe-
cifies the percentage of  the image to include in the composite.

NOTE: As you make the changes, the image in the Object box updates accordingly. If you want to preview any new 
changes in the Image Gallery, return to the Image Gallery and select the View drop-down menu to your new view. 
Then return to the Image Gallery Properties window and click Preview Changes in Gallery.

4.    Continue to add images as desired.
5.    To remove and image from the composite, click Remove Image.
6.    The composite is automatically added to the list on the left.
7.    A composite can be removed from the list by clicking Delete. 
8.    Continue customizing the Image Gallery display properties with another procedure in this section, or click OK to fin-

ish and save changes or Cancel to finish and discard changes.

Work with Individual Channel Images
You can work with individual images in the Image Gallery. You can zoom in or out on the images. You can add a larger 
version of an image to the Analysis Area for further analysis, show or hide masks for a single image in the Image 
Gallery, and copy one or more images to the Clipboard.
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Manipulate Individual Images
1.   In the Image Gallery, right-click an image that you are interested in. A menu displays:

 l To place the image in the Analysis Area, click Add Image to Analysis Area.
 l To show or hide the masks for the object image, click Show Masks or Hide Masks. One or the other will 

appear, depending on the current state.
 l To turn the colors on or off for the object image, click Color On or Color Off. One or the other will appear 

depending on the current state.
 l To show or hide the saturation color for the object image, click Show Saturation Color or Hide Saturation Color. 

One or the other will appear depending on the current state.

Copy or Save Images for Use in Reports
1.   In the Image Gallery, right-click an image that you are interested in. A menu displays:

 l To copy or save the single channel image to the Clipboard, choose   Copy/Save Image
 l To copy or save all of the channel images of one object, choose   Copy/Save Object Images.
 l To copy or save the single channel image for all of the displayed images to the Clipboard, choose   Copy/Save 

Gallery Column.
 l To copy or save all the visible images in the Image Gallery choose Copy/Save Gallery.
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Overview of the Mask Manager
A mask defines a specific area of an image to use for feature-value calculations. The IDEAS® application contains a 
Mask Manager for viewing existing masks and creating new ones. 

When the IDEAS application loads a .rif file, the application creates a segmentation mask for each channel image and 
stores the mask along with the image in the .cif file. The masks, labeled M01 through M12, contain pixels that are detec-
ted as brighter than the background. In addition, the application generates a Combined Mask, named MC and a Not 
Combined Mask, Not MC for each object. A combined mask consists of the union of the masks of all the channels of the 
object. A Not Combined Mask is all of the pixels with no intensities above background.

You might need to adjust the masks or create new ones that include only a specific area of a cell, such as the nucleus. 
You can combine masks by using Boolean logic, or you can adjust them by applying functions.

Create New Masks with the Mask Manager
There are two ways to work with new masks in the Mask Manager. First, masks can be created by using functions, 
which allows you to choose an input mask and, if needed, adjust the channel and scalar input. Alternatively, masks can 
be created by combining masks through Boolean logic.

Create a New Mask Using Functions
1.   Select Analysis > Masks. The Mask Manager opens with a list of existing masks on the left.
2.    Click New. The right side of the window is enabled to define a new mask.
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3.    Click Function. The Define Mask Function window appears with 19 available masks to use. Select a mask function 
from the Function drop-down menu to define that function. Available mask functions are: 

 l AdaptiveErode
 l Component
 l Dilate
 l Erode
 l Fill
 l Inspire
 l Intensity
 l Interface
 l LevelSet
 l Morphology
 l Object
 l Peak
 l Range
 l Skeleton
 l Spot
 l System
 l Threshold
 l Valley
 l Watershed

4.    Choose the input mask(s), channel and scalar parameters as needed. The right side of the window adjusts the dis-
play and view of the channel image. 

 l To view a different object in the file, select it in the Object list or type it's number.
 l To view a different image for the object, select it from the  list.
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5.    The Link inputs checkbox is checked by default. To modify a mask with different inputs, clear this box.
6.    Click OK.  The new function is added to the mask definition.
7.    Click OK. The new mask name will display in the list of Masks on the left side. 

Create a New Combined Mask
1.   Select Analysis > Masks.
2.    Click New.
3.    Use the Masks list on the left and the Definition toolbar to build a new mask using the definitions of existing masks 

with Boolean logic explained in the table below.  

Table 12. Mask Tasks and Toolbar

Task Toolbar

Add a mask to the definition.

Double-click the feature in the Masks list. 

Or, single click the feature in the Masks list and click the leftmost down-arrow 
button ( ) on the toolbar.

Combine two masks.

Use the Boolean AND or OR operator. 

Use the AND operator to include only the pixels that are in both of the ori-
ginal masks. 

Use the OR operator to include the pixels that are in either one of the ori-
ginal masks.

Select all pixels that are not in the 
original mask. 

Use the Boolean NOT operator ( ). The NOT operator specifies which 
mask will not be used.

Affect the order of operations. Use the parentheses toolbar buttons.

Remove an item from the end of 
the definition. Click the left-arrow button ( ) on the toolbar.

4.    Add masks and Boolean logic to the definition as needed. 
5.    Click OK to add the definition to the Masks list.
6.    Click Close.

Example of Creating a Function Mask and a Combined Mask
Here is an example of creating a mask of the cytoplasm. Similar operations could be done for the cell surface.
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In this example, cells were stained with a green intracellular marker (in Channel 2) and a red nuclear dye (in Channel 
11). You can generate a cytoplasm-specific mask by first refining the intracellular and nuclear masks and then removing 
the nuclear mask pixels from the intracellular mask.

1.   Observe the default masks in the Image Gallery. Since the default masks are designed to capture all the light in an 
image, they tend to include light that exists beyond the perceived boundaries of the images. In this case, both the 
intracellular and nuclear masks need to be refined. Start by creating morphology masks for both channel images 
because the Morphology mask is designed to conform to the shape of the image. 

NOTE: The Object mask function may also be used in place of the Morphology mask function. 

2.    Select Analysis > Masks.

3.    Click New.

4.    Click on the Function toolbar button ( ) to adjust the mask that will define the whole cell. The Define Mask 
Function window displays.
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5.    Select Morphology in the Function list. It will be important to have an appropriate cell selected. You can change the 
object number by typing in the box. Some functions are iterative, in which case you can change the mask selection.  
For example, dilate a morphology mask.

6.    Select a starting Mask.
7.    Select Channel 2 (intracellular marker) on the left side of the window. 
8.    Click OK. 
9.    Click OK to add this mask to the list. 

The default names are ideal for recall.   The new mask will be defined in the list of masks on the left panel.  The mask 
definition can be recalled in the definition box by selecting the mask in the left panel.

10.   To make the Morphology (Nuclear) mask, repeat steps 3–9 using Channel 11.
11.    Click Close. 

12.   To view the resulting morphology masks, open the Image Display Properties window ( ) and, if necessary, select 
the new mask(s) for the channel. 
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13.   Next, you will subtract the nuclear morphology mask from the intracellular mask using Boolean logic. In the Mask 
Manager window, click New.

14.   Double-click the Morphology(M02,Ch02) mask in the list.

15.   Click the AND ( ) button on the toolbar.

16.   Click the NOT ( ) button on the toolbar.
17.   Double-click the Morphology (M11,Ch11) mask in the list.

18.   The default name may be very long: edit as desired.
19.   Click OK to add this mask to the list.
20.   Click Close.

To view the resulting masks, open the Image Display Properties window and create a new view with the masks showing.
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View and Edit a Mask

View a Mask Definition
1.   Select Analysis > Masks. The Mask Manager window appears. 

2.    Click a mask in the Masks list to view the definition in the Definition area.
3.    Click Close.

Edit a Mask Function
1.   In the Mask Manager window, select the mask that contains the function you want to edit.
2.    Click Edit.

3.    Remove the definition for the combined mask using the back arrow tool ( ) as needed.

4.    Alternately, click the Function button on the toolbar ( ) for a function mask. The Define Mask Function win-
dow displays.

5.    Click OK when finished.
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View Masks in the Image Gallery:
After creating masks in the Mask Manager, you may wish to view them in the image gallery for evaluation.

1.   Click the Image Gallery Properties toolbar button ( ) to begin. The Image Gallery Properties window appears 
with the Display Properties tab displayed. 

2.    Click the Views tab.

3.    Click New.
4.    Type a name for the view.
5.    Click Add Column.
6.    Choose the Image and Mask from the drop-down menus.
7.    Continue to add columns until done. In this example, the view will contain a Ch02 image with the Morphology mask, 

default mask, and no mask followed by a Ch11 image with the Morphology, default, no mask. 
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8.    To view the masks in the image gallery, choose the view in the Image Gallery drop-down menu and turn the masks 
on by selecting the icon.
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Overview of the Analysis Area
The Analysis Area provides display space for individual images, plots of cellular feature values, tables of population stat-
istics, tables of object feature values, and text annotations. You can select different layouts for the IDEAS® window and 
placement of the analysis area and expand the Analysis Area by dragging it’s boundaries.

The graphs are created into panels of a default size and can be re-sized by dragging a corner or using the size tool. The 
position of the panels is automatically adjusted to fit in the available display space. A vertical scroll bar appears when the 
number of panels exceeds the space available on the window. The panels can be re-tiled using the arrange analysis 
area tool.

As illustrated by the following figure, the Analysis Area can contain several types of panels: histogram, histogram over-
lay, scatter plot, tables of population statistics or object feature values, channel image, composite image, and text. Each 
panel will contain its own toolbar and context menu. To move a panel click on the name at the top of the graph and drag 
it to a new location. A graph may be selected and then a right click in a blank space in the work area allows you to 
choose paste in the new location.

A toolbar is visible at the top of the Analysis Area. The Analysis Area Tools table describes the function for each tool.
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Analysis Area Tools
Table 13. Analysis Area Tools

Tool Description

 Pointer Tool

Provides the normal mode of interaction with the graphs. Clicking a point on a scatter-
plot graph causes the IDEAS® application to display the corresponding image in the 
Image Gallery (if the population that is currently displayed in the Image Gallery con-
tains that point). 

Click the bin in a histogram to select the bin. In the Image Gallery, you can view 
images of cells in the bin by choosing the Selected Bin population. 

Click Pointer Tool while drawing a region on a graph to cancel the creation of a 
region.

Tagging Tool Allows you to create a population of hand-picked objects.

 New Histogram Tool Creates a new histogram.

 New Scatter Plot Tool Creates a new scatter plot.

Populations Statistics 
Table

Creates a table to display population statistics.

Object Feature Values 
Table

Creates a table to display selected object feature values.

 Text Tool Allows user to add text notes to the Analysis Area.

 Line Region Tool

Draws a horizontal line on a histogram to define a region.

 Rectangle Region Tool Draws a rectangular region on a scatter plot. 

 Oval Region Tool Draws an oval region on a scatter plot. 
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Tool Description

 Polygon Region Tool
Draws a polygon region on a scatter plot graph. Each click starts a new segment in the 
polygon until the entire image is double-clicked to complete the region. 

 Wizards Tool Short-cut to using Wizards for guided analysis.

 Building Blocks Tool Short-cut to using Building Blocks for guided analysis.

Select All Tool Selects all panels in the analysis area.

 Tile Graphs Tool
Tiles graphs in the analysis area after changing the size of the analysis area to fit all 
graphs to the new space.

Layout Tools Switches the layout of the image gallery and analysis area.

 Graph Bkgd Tool Changes the background of the graphs to black or white.

Graph sizing Tools
Changes the size of selected graphs to small, medium or large.

Create Graphs
You can add two types of graphs to the Analysis Area:

 l Histogram—Graphs a single feature.
 l Scatter Plot—Graphs two features.

NOTE: Building blocks are available that will help you to create graphs for finding single, focused, fluorescent positive 
events or a size versus scatter plot.
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Create a Graph Without Using a Building Block

1.   Click the New Histogram ( ) or New Scatter Plot ( ) toolbar button. The New Histogram or New Scatter plot 
window appears, respectively.

2.    Select the one or more populations to graph by clicking them. To select more than one population, use the Ctrl key.

NOTE: The title defaults to the selected population. You can edit the title.

3.    In the X Axis Feature drop-down menu, select the feature that you want to graph on the X Axis.
4.    To change the label for the X axis, edit the text in the X Axis Label field. The label defaults to the name of the selec-

ted feature. 
5.    (Optional) If you are creating a scatter plot, select a feature and a label for the Y Axis.
6.    (Optional) If you are creating a histogram, you can choose to normalize the Y axis frequency and change the bin 

count.
7.    The default font sizes are used, you may change them by clicking Font Sizes.
8.    Assign colors by Population (default) for dot plots or by Density for density plots.
9.    Set the scaling for each axis of the graph. (The default is Auto, which allows the application to automatically scale 

the graph.)
10.   To set minimum and maximum values for an axis, select Manual.
11.    Select Linear or Log and enter Maximum and Minimum limits.
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12.   If you selected Log, enter the X > value.

NOTE: You can scale the X Axis of a graph or the Y Axis of a scatter plot in one of two modes: Linear or Log. The 
Linear mode is the default.

The Log mode allows you to logarithmically scale a section of the graph or scatter plot. Selecting this mode causes 
the IDEAS® application to perform bi-exponential plotting. The > X value defines the linear portion of the graph as -
X through X. The application plots the values outside of these limits on a logarithmic scale. You can plot negative 
values as well as positive ones on a logarithmic scale by adjusting the limits.

Take care not to split a population such that it appears to be two separate populations. This splitting is especially 
likely when negative values exist due to compensation or corrections on the imagery. The graph on the left side 
was plotted on a linear scale; the ones in the center and on the right side were plotted on logarithmic scales. The 
graph on the right side split the population because the change from a linear to a logarithmic scale occurred in the 
middle of the population. In general the >X value should be 1000 for 40 and 60X data and 100 for 20X data.

NOTE: The font sizes can be changed for an individual graph.

13.   Click OK.

NOTE: Right-click in the graph to bring up the context menu.  Graph Properties will open the same window that you 
used to create the graph will reappear, and you can then make any changes that you want.

For Research Use Only. Not for use in diagnostic procedures. 94

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



Show Selected Statistics for a Graph
1.   Show and hide statistics by clicking the Statistics toolbar button in the panel that contains the graph.

2.    Alternately, right-click anywhere on the graph and click Statistics on the graph context menu that appears. The Stat-
istics window appears.

3.    Select the statistics that you want to display. Select the View statistics box and the box next to the statistic to be dis-
played for each population on the graph. The statistics that are supported are the Count, Percent Total, Percent 
Gated, Percent, Concentration (count/sample volume), Mean, Median, Standard Deviation, MAD (Median Average 
Deviation) RD -Mean, RD -Median, CV, Minimum, Maximum, Geometiric Mean, Mode, variance, and NaN (not a 
number).

4.    When finished, click Close.
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Show the Legend for a Graph
1.   Right-click anywhere on the graph, and click Show/Hide Legend on the graph context menu that appears.

If the legend was hidden, it appears on the graph. If the legend was shown, it disappears from the display.

NOTE: The legend contains an entry for each population on the graph. If the graph is a scatter plot, the legend 
shows the population and its associated point style and color. If the graph is a histogram or overlay histogram, the 
legend shows the population name, associated color, and line type. 

2.    To move the legend, click and drag it.

NOTE: You cannot drag the legend past the boundary of the graph panel.

Order the Plots on a Graph or Change the Fill and Lines for a Histogram:
Right-click anywhere on the graph and choose Plot Order and Properties on the graph context menu that appears. The 
Display Properties dialog appears.

Move a Graph
With any graph in the Analysis Area, you can move it to another location by clicking in the center of the graph and drag-
ging it. 

Alternatively, select the graph, right-click in the a blank space in the analysis area, select Cut, right-click where you 
would like to move the graph, then select Paste.

Create Regions on Graphs
Regions may be drawn on graphs to create new populations, based on the physical location of objects on a graph, and to 
compute statistics. Tools for drawing regions are found on the Analysis Area toolbar. A line region may be drawn only 
on a histogram. All other types of regions may be drawn only on a scatter plot. 

A region can be copied to another graph in the same file or other open files. Regions may also be copied from one 
instance of the IDEAS® application to another.

When you draw a region on a histogram or scatter plot, you create a population of objects defined by the region that 
may be viewed in the Image Gallery or on other graphs. 

Draw a Region on a Scatter Plot
1.   On the Analysis Area toolbar, select one of the following Region icons:

 l  Rectangle Region 

 l  Oval Region

 l  Polygon Region 
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2.    If you selected the Rectangle or the Oval tool:

a.   Click on the graph at the point where you would like to start the region and drag to the region endpoint. The 
region grows as you drag.

b.   Click again to complete the region.                If you are drawing a region on a histogram or scatter plot, the Create a 
Region window appears.

c.   Name the region.

d.   Click the colored box to select an alternate color.

e.   Select Use for statistics only if you do not want to create a population from this region. 

f.   Click OK.The region appears on the graph with the name and color that you selected.

              

3.    If you selected the Polygon tool:

a.   Clicking the scatter plot at the point where you would like to start the polygon.

b.   Click once for each vertex of the polygon.

c.   Double-click to complete the drawing of the region. A window appears that allows you to name the population 
created by the polygon region and to assign the region’s display properties.

d.   Click OK. The region appears on the graph with the name and color that you selected.

NOTE: Before you click OK, you can click Cancel or you can click the Pointer button ( ) on the Analysis Area 
toolbar if you decide not to create the region.

Draw a Region on a Histogram

1.   On the Analysis Area toolbar, click the Line Region tool ( ). 
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2.    Drag the line across the histogram.

 

Move or Resize a Region on a Graph

1.   Click the Move/Resize Region toolbar button ( ) on the graph panel toolbar.
2.    Click the region that you would like to move or resize. When the region is selected, squares that can be moved 

appear at the vertices and the label. The first time that you drag the region, the entire region and label move.
3.    Drag a specific vertex or label to move only that vertex or label.
4.    To finish moving or resizing the regions on the graph, click the Move/Resize Region toolbar button again to deac-

tivate the tool. The populations and statistics are updated, and the Move/Resize Region toolbar button is deac-
tivated.

NOTE: The recalculation of statistics and populations may take a moment if the data file is large or if many pop-
ulations are dependent on the regions that are being moved or resized.

Zoom in on the Scale of a Graph

1.   Click the Scaling toolbar button ( ) on the graph panel toolbar. 
2.    Click and drag to define a rectangular region for rescaling. The Zoom Out Scaling toolbar button ( ) appears in 

the graph panel toolbar, next to the Scaling toolbar button. 
3.    Click the Zoom Out Scaling toolbar button to automatically scale the graph. The Zoom Out Scaling toolbar button is 

removed from the graph panel toolbar.

Resize a Graph
1.   Select the graph(s) to be resized and then click the appropriate sizing button tool: Small, Medium, or Large.

2.    Resize the graph by dragging the right, bottom, or lower-right corner. 

NOTE: Select multiple graphs to make them all the same size.
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Copy and Paste a Region to Another Graph
1.   Right-click anywhere on a graph and click Copy Region to Clipboard on the graph context menu that displays.

The Copy a Region to the Clipboard window displays.
2.    Click the region to copy in the list and click OK.
3.    Right-click on the graph where you want to paste the region, then click Paste Region from Clipboard on the graph 

context menu that displays.
4.    If the region already exists (in other words, you are copying it within the same instance of the application), the 

Create a Region window displays. 
5.    Rename the region and set the display properties for the resulting new population, and click OK.

NOTE: When you copy a region, the scale is copied and is no longer associated with the feature from which it was 
originally drawn. Therefore, the region might not fit on the new graph.

Apply or Remove a Region on a Graph
1.   Right-click anywhere on the graph, and click Apply/Remove Region on the graph context menu that displays. The 

Apply Graph Regions window displays.

2.    Select the regions that you want to appear on the graph.
3.    Clear the regions that you want to remove from the graph.
4.    Click OK.

Show or Hide a Population on a Scatter Plot:
1.   Click Show/Hide Populations on the graph context menu. The Show/Hide Populations window displays.
2.    Select the populations that you want to appear on the graph.
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3.    Clear the populations that you want to remove from the graph.

4.    Click OK.

NOTE: On a scatter plot, you may show or hide any population on the graph, regardless of the features on the axes. 
Each scatter plot has an original, or base, population. When you show a population on a scatter plot, only those 
objects that are also in the base population will be shown. To aid in the identification of the populations shown, 
change the characteristics of the population(s)  in the population manager.

Analyze Individual Images
To analyze an image in more detail, place the image in the Analysis Area to view pixel positions and intensities as well 
as generate statistics for an area of the image. You can also show the Measurement tool for the image.

Image panels, which are shown in the following figure, each contain a toolbar in the upper-right corner and a context 
menu that appears when you right-click an image. An image in the Analysis Area is three times the size of an image in 
the Image Gallery.
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Add an Image Panel to the Analysis Area 
Right-click an image in the Image Gallery or Analysis Area, then select Add Image to Analysis Areaon the context menu 
that appears. The image panel appears in the Analysis Area.

View the Individual Pixel Intensities of a Single Channel Image
Move the mouse pointer across the image. The pixel positions and intensities appear under the image. (The pixel (0, 0) 
is positioned at the upper left of the image.)
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Display the Measurement Tool in an Image Panel
Right-click the image panel, and click Show Measurement Tool on the context menu that displays.
The 10-micron bar displays.
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Examine a Line Profile or the Statistics for an Area of an Image

Click on the red line icon ( ) in the image toolbar to open the line profile tool, then click and drag to create a boxed 
area on the image.

The Image Statistics are shown in the image panel. The statistics are calculated for the area that is defined by the box. 
The line profile (the wavy line in the image panel) represents the pixel intensity at each position along the red line of the 
box.
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Change the Display Properties of an Image

1.   Click the Channel Display Properties button ( ) on the image panel toolbar. The Display Properties window 
appears.
a.   For single channel image, change the displayed mask and adjust the display intensity mapping. 
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b.   For a composite image, change the images in the composite and adjust the percent contribution of each image.

2.    Click OK.

Show or Hide the Mask for a Single Channel Image
1.   Click the Mask button on the image panel toolbar, or right-click the image and then click Show/Hide Mask on the 

image context menu.  The mask appears as a transparent overlay on the image.

Turn the Color On or Off: 
1.   Click the Color button on the image panel toolbar, or right-click the image and then click Color Off or Color On.
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View the Object Feature Values
The Object Feature Values table displays a selected set of feature values for selected objects. For each feature, the 
name, value, and description are shown.

View and Customize Object Data Table Features

1.   Click the Object Feature Values tool. 
2.    Right-click anywhere in the table area to open the menu.

3.    Select Select Features. The Select Object Features window displays.

4.    Select the features to view. Multiple features may be chosen by holding down the Ctrl key.
5.    Click OK. The features appear in the Object Data table.
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6.    To add selected objects to the table right-click and choose Add Current Object.

Export or Copy Feature Values
1.   Right-click in the table and choose Copy feature values to clipboard from the drop-down menu. 

Add Text to the Analysis Area

1.   Click the Text button ( ) on the Analysis Area toolbar. A text panel is added to the analysis area.

2.    Enter a title in the title box and and text in the text box.

Population Statistics
The Population Statistics table displays selected statistics for chosen populations. The statistics that are supported are 
the Count, Percent Total, Percent Gated, Percent, Concentration (count/sample volume), Mean, Median, Standard Devi-
ation, MAD (Median Average Deviation) RD -Mean, RD -Median, CV, Minimum, Maximum, Geometric Mean, Mode, 
Variance, and NaN (not a number).  

View and Customize Population Statistics

1.   Click the Populations Statistics tool. 
2.    Click the + next to the population to expand the list of populations.
3.    Columns can be moved by clicking an dragging.
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4.    Right-click in the gray area in the table or on a column heading. The context menu opens.

5.    To open a Statistics Properties window to enable changes to multiple column statistics, click Edit Statistic Tabl.
6.    To add a single statistic column, select Insert Column.
7.    To make a change to a column, select Edit Column.
8.    To delete a single column, right-click on that column and select Delete Column.
9.    To clear all statistics, select Delete All Columns.
10.   To place all columns in the default order, select Order Columns.
11.    To copy the selected rows of the table in a text format that can be pasted into other programs such as Microsoft® 

Excel, select Copy Statistics.
12.   To copy the selected rows of the table and transpose the data so that the rows become columns when pasted into 

other programs such as Excel, select Copy Statistics - Transposed.
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Use the Feature Manager
This section describes how to create and delete features and to create multiple features by selecting categories.

Overview of the Feature Manager
The IDEAS® application defines a set of base features that you can use to create features for each object. To do so, you 
use the object’s mask and/or its channel images. After a feature has been created and its value calculated for all cells, 
you can plot the feature values or view them as statistics for any population.

When the IDEAS application opens a .cif or .rif file, the application calculates the values of features as defined by the 
selected template. You can refine your template so that it includes only those features of interest for your experiment. 

You use the Feature Manager to examine existing features and to define new ones. To gain access to the Feature Man-
ager, select Analysis > Features, or select it from one of the context menus that are available in the histogram and scat-
ter plot panels with a right-click. While the Feature Manager is open, all calculations for creating graphs and statistics 
are disabled. However, you may view images and change the population and channel views. When you close the Feature 
Manager, any changes to feature names, definitions, and values are reflected in any currently displayed graphs and stat-
istics. The values of newly created features are also calculated at this time.

You can create single features and combined features. You create a single feature by selecting a base feature, such as 
Area or Intensity, along with a mask and/or an image.  You can create a combined feature by defining a mathematical 
expression that includes one or more single features that exist in the feature list. 

Some features, such as Area, depend on the boundary of a cell. These features require you to select a mask that defines 
the portion of the image to use for the calculation. Other features, such as Max Pixel, depend on pixel intensity meas-
urements and require you to select an image. Other features require you to select a mask and one or more images. 

You can add and remove features from the feature list. The feature definitions are stored in templates, so the definitions 
are available when you analyze multiple data files. The default template used for ImageStream® data  includes most of 
the base features for each channel image and channel mask that the feature list contains. Certain features, such as Sim-
ilarity and Spot, require extensive calculations so the default template does not include them. The reason is to save time 
when you load files. However, you can add these features to the feature list. 
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View Existing Feature Definitions
1.   Click Analysis > Features, or select Features from a graph panel context menu. The Feature Manager window 

appears.

2.    Choose an icon to sort the features:

Table 14. Sorting Features Icons

Feature 
Icon Function

Sorts features alphabetically.

Sorts features based on the images used. 

Sorts features based on the masks used. 

Sorts features by category, such as size, location, shape, texture, signal strength, and sys-
tem.

Sorts by base features, such as area, aspect ratio, intensity, and object number. 

3.    Click a feature in the Features list to view its definition in the right side of the window.

Create New Features with the Feature Manager

Create a Single New Feature
A single feature uses the definitions of a base feature along with a mask and/or an image.
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1.   Click New in the Feature Manager. The right-hand area of the Feature Manager is enabled.

2.    Select Single as the Feature Typeand choose the base feature in the drop-down menu. The Mask and Image lists 
become visible, depending on the single feature selected.

3.    Select the mask and/or image that you want.
4.    Click Set Default Name. The default name is the name of the base feature followed by the name of the mask and 

name(s) of the image(s). 
5.    Click OK to add the new feature. It appears in the Features list on the left side of the Feature Manager.
6.    Click Close.

NOTE: When you close the Feature Manager, the IDEAS® application calculates values for the new features. These 
calculations may take several minutes, depending on the number and complexity of the new features and the size 
of the image file.

Create Multiple New Features
1.   Click Add Multiple Features in the Feature Manager.
2.    Sort the feature list alphabetically or categorically. 
3.    Select multiple base features and masks.
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4.    Select image(s) or check the box to create for all channels using default masks and images.

5.    Any list can be cleared by clicking the Clear Selected button.
6.    When finished, click Add Features to add the new features to the list.
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7.    Confirm the features in the next window.

8.    Delete any features you do not want to calculate.
9.    Click OK when finished. The new features are added to the list in the feature manager.
10.   Close the Add Features window.
11.    Close the Feature Manager. The new features are calculated when the feature manager closes.

Create a New Combined Feature
A combined feature uses one or more single features created by a mathematical expression. 

1.   Click New in the Feature Manager.  The right hand area of the Feature Manager is enabled.
2.    Select Combined as the Feature Type. The editing interface appears.

3.    Enter the feature name in the Name box or use Set Default Name after you have created your expression. The 
default name is the name of the definition created. 
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4.    Use the toolbar to build a definition (mathematical expression) of features and operators: 

Table 15. Combined Feature Tasks and Toolbar

Task Toolbar

Add a feature to the definition.

Double-click the feature in the Features list. 

Or, single click the feature in the Features list and select click the leftmost down-
arrow button ( ) on the toolbar.

Add an operator or a parenthesis 
to the definition.

Click the corresponding button on the toolbar.

Add a number to the definition.

Enter the number in the box and then click the corresponding down-arrow but-

ton. 

If the area is greyed-out, an operator must be selected first. 

Add a function to the definition.

Select the function in the list and then click the corresponding down-arrow but-
ton.

The available functions are ABS (absolute), COS (cosine), SIN (sine), SQR 
(square), and SQRT (square root).

If the area is greyed-out, an operator must be selected first. 

Remove an item from the end of 
the definition. Click the left-arrow button ( ) on the toolbar.

5.    Click OK.
6.    Click Close.

NOTE: When you close the Feature Manager, the IDEAS® application calculates values for the new features. These 
calculations may take several minutes, depending on the number and complexity of the new features and the size 
of the image file.
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Delete a Feature
1.   Select one or more features in the Features list by clicking them. To select more than one feature, use the Ctrl key.
2.    Click Delete. A warning message will confirm or cancel deletion.

NOTE: Deleting a feature also deletes any populations that are dependent on that feature. Your feature list may 
become large and unwieldy. You can narrow down the list without deletions by sorting the list. 

Create Multiple Features and Rank Features by Discriminating Power
With the IDEAS® application, you are able to create an unlimited set of features by using the Mask Manager to define loc-
ation and the Feature manager to choose a mathematical expression that uses the image pixel data and/or the mask. 
This can make it challenging to choose a feature that provides good statistical separation of populations of cells that 
have different appearances from each other. 

IDEAS versions 6 and up include the 'Feature Finder' wizard, which creates a set of masks and features automatically 
and determines the features with the most discriminating power for the chosen truth populations. It may be useful for 
certain applications to create new masks and features that are not created by the wizard. Once features are created 
using this manual method, the Feature Finder wizard will test all features in the data file.

A general description of the steps is followed by a specific example.

General Workflow
1.   Set image display and draw preliminary regions to include cells of interest (i.e., single, focused, positive cells).
2.    Visually inspect overall quality of images and experiment to determine whether to proceed or redo the experiment.
3.    Create two tagged ‘truth’ populations of cells that represent the phenotypes you wish to discriminate. Perform the 

discrimination on one characteristic difference at a time.
4.    Create any additional masks and features you think may help differentiate the truth populations.
5.    Calculate the statistical discrimination (RD) between the two populations afforded by features in 1 category at a 

time. Pick the top feature for each category. Alternatively, use the Feature Finder wizard which measures the RD 
but only keeps the three features per category with the highest RD.

6.    Plot the features with the highest RD for the truth populations for each category
7.    Validate by applying the feature to the base population, independent controls if available and on multiple files and 

experiments.

Example
Treatment-induced actin polarization. The data file is available for practice.

 l Cells were incubated with inducing compound for 1 hour.
 l The nucleus was probed with DAPI and actin stained with FITC.
 l Large event image files were collected on the ImageStream® instrument.

 l Compensation and analysis was done in IDEAS® software.

The following steps find the best features that distinguish changes in actin distribution.

1.   Gate single, focused, actin-positive cells. View cells of interest.
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2.    Create the truth populations from within the cells of interest using the tagging tool.

NOTE: If truth populations are in different files, merge them together before beginning. When selecting truth pop-
ulations, choose images that represent the full phenotypic range of each truth. In this example case, note that the 
‘uniform actin’ truth population contains cells of varying shape and intensity that all have uniform actin distribution. 
Bias introduced during the selection of truth populations will likely also bias the outcome during statistical ranking.
The following figure shows the truth populations chosen to find a feature to discriminate uniform versus polarized 
actin:

3.    Create the Morphology and one or more Threshold masks for the actin image.
4.    Create features from the Size, Shape, and Texture categories using the Morphology, Threshold and Default actin 

channel masks.

a.   Choose Features from the Analysis menu and click Add Multiple Features.
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b.   In the Add Features window select Category as the ‘Sort Order’. 

c.   Check Size, Shape and Texture base feature boxes.

d.   Select the actin masks (Morphology, Object, Threshold, M02)

e.   Select the actin image (2_Actin).

f.   Click Add Features to display the list of features to add.

g.   In the next window, click OK to add the features. Features that already exist will not be recalculated. 

h.   Click OK and click Close.

i.   Close the Feature Manager by clicking Close. The features are calculated.

5.    Add the feature statistics to the population statistics table. Do this one category at a time. Multiple statistics tables 
can be added to the analysis area, one for each category of features. Alternatively, go  to the Feature Finder wizard 
to continue with the RD calculation and ranking.

6.    Once the features are calculated you can use the RD, (Fischer's Discriminant Ratio) to a statistics table. The RD 
measures the separation between two populations. In this case, the two truth populations picked in Step 2. In order 
to get the statistic for one category at a time, select all of the features for the image and then deselect categories to 
leave one category for the channel selected.

a.   Click on  to add a statistics table to the analysis area.

b.   Right-click in the table and choose Edit Statistics Table.

c.   Delete any statistics from the list.

d.   Select the RD –Mean statistic .
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e.   Select one of the truth populations in the Reference population box.

f.   Sort by Images Used by clicking on the icon .

g.   Check the box for the Ch02/Actin image.

h.   Sort the features by Category .

i.   De-select all but one category by checking and unchecking the box for the categories you want to de-select. 

NOTE: The box next to the category will be checked only if all of the features (all channels) in the category are 
selected.

j.   Click Add Statistics.

k.   Click Close.

l.   Repeat Step 6 each statistics table contains 1 category of features for Ch02(Actin).

7.    Launch Microsoft® Excel, and then Copy and Paste the statistics into the Excel spreadsheet.

a.   Select the row of statistics for the 2nd truth population (the one not chosen above). 

b.   Right-click in the statistics table and choose Copy Statistics - Transposed. 

c.   Paste into an Excel spreadsheet.
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d.   Keep all of the features and values selected and sort the data set on the values column (heading may be the 
population name) largest to smallest. The feature with the largest RD will be at the top. 

NOTE: You may have NaN values for some of the features. This means Not a Number and occurs in some 
cases when there is a division by 0. These can be ignored.

8.    Validate the features in IDEAS. Plot the features with the highest RD for the truth populations and draw regions to 
discriminate.

9.    Apply regions to the base population, independent controls if available and on multiple files and experiments.
10.   Look for false negative and positive cells.
11.    Repeat process if necessary by refining/creating new truth populations.

NOTE: When evaluating features, consider the features that produce the highest RD. If there are any intensity based 
features make sure that the staining was not uneven due to technical issues. If it is a size feature, does it make sense 
with what you know about the cells and biology of your experimental system? Since the feature value ranges vary 
between features this is an approximate comparison and the result should be validated by viewing images across the 
feature range from the whole population.
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Use the Population Manager
A population is a group of objects. You create populations by drawing regions on graphs, by hand-selecting (tagging) 
objects in the Image Gallery or on plots, or by combining existing populations. After a population has been defined, you 
can view it in the Image Gallery or on a plot and you can use it to calculate statistics.

The Population Manager provides a central place for maintaining the display properties of existing populations and for 
creating new combined populations.

Open the Population Manager and View Population Definitions
1.   Select Analysis > Populations or right click a graph and select Populations. The Population Manager window dis-

plays. 

NOTE: The list of populations is presented as a hierarchy that shows the dependencies of the populations on each 
other. The icon associated with a population indicates how the population is defined.

Icon Defined by

Tagging

Region

Combined

NOTE: The definition of a selected population is shown in the Definition area.

Edit the Display Properties of a Population
1.   Within the Population Manager, click a population in the Populations list.
2.    Change the name in the Name box.
3.    Click a Color square to select a new color on the color palette and click OK.
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4.    Click a display symbol in the Symbol drop-down menu.
5.    Click Close to save the population changes.
6.    Click Revert to reject the changes.

Delete a Population
1.   Within the Population Manager, click a population in the Populations list. 
2.    Click Delete. A confirmation warning message appears indicating all the dependent populations that will also be 

deleted.
3.    Click Yes to confirm.

Create a New Combined Population
1.   Within the Population Manager (Analysis > Populations), click New. The right side of the Population Manager win-

dow changes to allow you to define a new population.

2.    Enter a unique population name in the Name box.
3.    Click a Color square to select a new color on the color palette and click OK.
4.    Click a display symbol in the Symbol drop-down menu.
5.    Use the toolbar to build the population definition as described in the table. Click OK when done: 
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Table 16. Population Tasks and Toolbar

Task Toolbar

Add a population to the definition. Select the population from the drop-down menu. 

Combine two populations.

Use the Boolean AND or OR operator. 

Use the AND operator to include only the objects that are in both of 
the original populations. 

Use the OR operator to include the objects that are in either one of 
the original populations.

Select objects that are not in the ori-
ginal population. 

Use the Boolean NOT operator. 

The NOT operator specifies which population will not be used. 

NOTE: You must use AND before NOT.

Affect the order of operations. Use the parentheses toolbar buttons. 

Remove an item from the end of the 
definition. Click the left-arrow ( ) button on the toolbar.
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Create Tagged Populations
You can hand-select objects from either the Image Gallery or a graph and group them into a population.

Create a Hand-Selected Population
1.   Click the Tagging Mode toolbar button ( ) to begin.  The Tagged Population window displays.

2.    Select either Update existing or Create New.

a.   To Create New, double-click images within the Image Gallery and select Save. Enter a new population name. 
Each population is given a new color and the symbol solid diamond for ease of viewing in plots.

3.    To Update existing, choose a population to update in the drop-down menu.
4.    In the Image viewing mode list, choose the mode that you want from the drop-down menu. 
5.    To add or remove an image from the tagged population, double-click either the image in the Image Gallery or a dot 

in a bivariate plot. The selected channel image for each tagged cell is displayed in the viewing area of the Tagged 
Populations window. In the Image Gallery, a small smiley-face icon appears on the left side of each tagged image. 
Each tagged object is also displayed as a yellow star in a graph in the Analysis Area. The number of objects in the 
tagged population is updated in the bottom, left corner.

6.    If you are updating an existing population, click the Update button in the Tagged Populations window.
7.    When you are finished updating, click Close in the Tagged Populations window.

NOTE: The tagging mode remains open until you click Close, and as long as the Image Gallery is in tagging mode, 
you cannot create, resize, or move any regions on the graphs. 

Create a Tagged Population from a File of Object Numbers
Use a comma-separated text file of object numbers to create a tagged population.
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1.   Navigate to File > Tools > Create Tagged Population.

2.    Browse for the file.
3.    Name the population, select the color, symbol and click OK.

Use the Region Manager to View and Edit Regions
The Region Manager provides a central place for defining the display properties, names, and positions of existing 
regions. Regions can be deleted in the Region Manager tool. 

If a file is going to be used as a template and you do not wish to change certain regions in the new daf files you may 
check the box 'When used as a template, do not overwrite this region' and the specific regions will be preserved in the 
new daf files. 

Regions are drawn on graphs to create new populations, based on the physical location of objects on a graph, and to 
compute statistics. Tools for drawing regions are found on the Analysis Area toolbar. 
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1.   Select Analysis > Regions or right click a graph and select Regions to open the Region Manager.
2.    To view a region, click a region in the Regions list. The selected region's settings display on the right side of the 

Region Manager.

3.    To edit a region, adjust the settings from the right side of the Region Manager.

a.   Change the name in the Name box.

b.   Click a Color square to select a new color on the color palette. Click OK from the color palette when finished..

c.   Change the X or Y position of the vertices in the Vertices box.

d.   Select or de-select the Use for statistics only box.

e.   Click Delete to delete a region.

NOTE: When a region is deleted, all populations that are defined by that region will be deleted. A warning 
dialog box appears listing the populations that will be deleted. 

f.   Click Revert to reject any changes made to the selected region.

4.    Click Close when finished with the Region Manager.

Create Reports and Export Data
Once you have finished analyzing an experiment, you will want to report the results into third party applications. To 
streamline the process, the first step is to define your application defaults, image gallery settings, and statistics report 
definitions. 
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Report Images and Graphs
The IDEAS® application allows users to copy and print images and graphs, and export statistics, feature data, pixel data, 
or TIF files for separate analyses. 

Prepare the Image Gallery and Analysis Area for Reporting
1.   Before you print or copy images, optimize the image display using Image Gallery properties.
2.    In addition to formatting the graphs and statistics in the Analysis area, the IDEAS® application provides color map-

ping from the dark mode that you see in the Analysis Area to a light mode that has a white background for the print-
ing and exporting of data. Because the population colors might not show on a white background, you can change 
the colors when using the light mode.

a.   Click the graph background tool ( ) to switch between light mode and dark mode for graphs in the Analysis 
Area.

b.   To map dark mode colors to light mode colors:

i. Select the Colors tab from the Application Defaults window.
ii. Select a dark mode color to map to a light mode color.
iii. Click Update Populations in Open Files.
iv. Click OK to save the changes or Cancel to exit.
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Copy Full or Partial Screens
 l To copy the entire screen to the Clipboard, press CTRL+PRINT SCREEN. The image is then available for past-

ing into a third party application.

 l To copy the IDEAS application window to the Clipboard, select the window and then press ALT+PRINT 
SCREEN.  The image is then available for pasting into a third party application.

Print the Analysis Area or Image Gallery Data Directly
 l To print the Analysis Area data, select Reports > Print Analysis Area. The IDEAS® application prints all the 

graphs, statistics, text panels, and images that are displayed in the Analysis Area.

 l To print the Image Gallery data, select Reports > Print Image Gallery. The IDEAS® application prints all the 
images that are visible in the Image Gallery.

Copy Images to the Clipboard or Save Images to Files
1.   Right-click anywhere in the Image Gallery and then choose one of the following options:

 l Copy/Save Image for a single image
 l Copy/Save Object Images for the row of images for one object
 l Copy/Save Gallery Column for the images of one channel in the current gallery
 l Copy/Save Gallery for all images in the current gallery

2.    A preview of the image(s) is shown. Changes from the default settings may be made to the following: 

 l Show Channel Names 
 l Object number
 l Scale bar
 l Text Color for channel names
 l Background
 l Number of rows and columns
 l Image Size and DPI settings
 l Font Sizes and Clipboard Format
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3.    (Optional) Click Save as Default Settings to save the settings as default, or click Load Default Settings to load set-
tings from a file.

4.    Click Save to File or Copy to Clipboard when done. Files may be saved as .png, .bmp or .tif formats.
5.    If Copy to Clipboard was chosen, paste the images into a third-party application.

Copy Graphs to the Clipboard or Save Graphs to a File
1.   Right-click anywhere in the graph and choose Copy/Save Graph and/or Statistic. 
2.    A preview of the graph is shown. Changes from the default settings may be made to the following: 

 l Include Graph
 l Include Legend
 l Include Statistics
 l Include Cursor
 l Show sample name in title
 l White background on/off
 l Graph size
 l Font sizes

3.    If changes are made, they can be previewed by clicking Generate Preview. Otherwise, changes will be applied 
when Save to File or Copy to Clipboard is chosen.

4.    (Optional) Click Save as Default Settings to save the settings as default, or click Load Default Settings to load set-
tings from a file.

5.    Click Save to File or Copy to Clipboard when done. Files may be saved as .png, .bmp or .tif formats.
6.    If Copy to Clipboard was chosen, paste the graphs into a third-party application.

To export graph statistics to the Clipboard, right-click a graph and then click Export Statistics To Clipboard. The graph 
statistics are available for pasting into a third party application.

For Research Use Only. Not for use in diagnostic procedures. 128

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



Copy Population Statistics from a Statistics Table
 l Right-click the table and then click Copy Statistics or Copy Statistics - transposed. They are then available for 

pasting into a third party application.

Report Statistics

Define a Statistics Report
A statistics report definition can be saved in a .daf file or an .ast template file. It allows users to select specific statistics 
within a .daf file and open the data in Excel. 

A statistics report can be generated during batching if it is part of the template used. It may also be applied to pre-exist-
ing .daf files from the Reporting menu. In this case, the rest of the template is not processed—only the report. The stat-
istics report definition allows you to specify population percentages and feature statistics and the layout of the report is 
accessed from the reporting menu.

1.   Select Reports > Define Statistics Report. The Statistics Report Definition appears.             

2.    Enter a Report title.
3.    Under the Statistic Columns clickAdd Columns. The Add Statistic Report Column window opens.
4.    Select the statistic(s) in the Statistics list.

 l Count - the absolute count of the populations
 l %Total - percentage of a population as a percentage of All
 l %Gated - the percent of one population as a percentage of another, but not used for tagged populations
 l % - the percentage of one population as a percentage of another, also is used for tagged populations
 l Objects/mL - the concentration of the population in the sample run.
 l CV - the coefficient variable
 l Geometric Mean - standard statistical definition
 l Maximum - standard statistical definition
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 l Mean - standard statistical definition
 l Median - standard statistical definition
 l MAD - standard statistical definition
 l Minimum - standard statistical definition
 l Mode - standard statistical definition
 l RD - Median - the ratio discriminant (Fisher's discriminant) using the Median and MAD
 l RD - Mean - the ratio discriminant (Fisher's discriminant) using the Mean and StdDev
 l Standard Deviation - standard statistical definition
 l Variance - standard statistical definition
 l NaN - stands for not a number; the number of objects whose values are not valid numbers.

5.    Select a population to base on the selected statistic(s).
6.    Select a reference population if necessary. This is required for % and RD.
7.    Select a Feature. This is not necessary for the %-related statistics, Count, or Objects/ml.
8.    Click Add Statistics.The statistic is added to the list.
9.    Click Close when finished.
10.   Select a statistic in the list to view the definition or edit any input.
11.    Change the name of the statistic by clearing Use default title and typing a new name if desired..
12.   Delete Columns removes a selected statistic.
13.   To reorder the list click-drag a statistic to it's new location.
14.   Click Generate Report when complete to generate a report for a current (opened) .daf file. A prompt appears to 

save the text file. This text file can be opened from Excel.
15.   If you do not want to generate a report, click OK to save your changes and exit the window.
16.   The saved template can generate a statistics report for multiple data files by selecting Generate Statistics Report 

from the Reports menu or during batch processing.
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Generate a Statistics Report using .daf Files
Once a Statistics Definition has been created, the user can generate a statistics report from multiple .daf files. However, 
these files must use the same template. Batch Processing can also generate a statistics report where statistics for each 
data file will be generated either for .rif, .cif, or .daf files. Generating a statistics report under the Reports menu simply 
adds the statistics template to the specified .daf files.

1.   Select Reports > Generate Statistics Report. The current .daf file appears in the window with the specified statistics 
columns.

2.    Pick a Report Definition. The definition may be obtained from a .daf or .ast file.
3.    Change the Report title if desired.
4.    Additional .daf files can be added or removed with the Add Files or Remove Files buttons.
5.    Reorder the files as desired by selecting files and then right-click the new location in the list and choose move here. 

You can use Ctrl select multiple files in the desired order, then move them all at once by right-clicking in the desired 
location and choosing Move Here.

6.    Click OK.
7.    A prompt will confirm that the .daf file will be saved. The report title name will be used as the default file name for 

the report. In the above example, the file generated will be named “Report 1.txt”. If the report title contains illegal 
characters—such as “\/><“—the default filename will change to “Statistics Report.txt”. Tab delimited text format is 
used for the report.

8.    View the report in IDEASby choosing View Statistics Report from the Reports menu. The report can be copied to 
the clipboard and pasted into a spreadsheet program or the .txt file can be opened using a spreadsheet program.
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Report Statistics from a Single Graph or Statistics Table
Statistics can also be reported directly from an open .daf from the graph or statistics tables in the analysis area.

 l To export graph statistics to the clipboard, right-click a graph and then click Export Statistics To Clipboard. 
They are then available for pasting into a third party application.

 l To copy population statistics from a Statistics Table, right-click the table and then click Copy Statistics or Copy 
Statistics - transposed. They are then available for pasting into a third party application.
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Export Data
You can export feature values for a population to the Clipboard, a text file, or a Flow Cytometry Standard (FCS) file. You 
can export pixel intensity values for an object to the Clipboard or a text file. Later, you can open or paste the FCS file into 
a spreadsheet or other programs that uses the FCS file format. Keep in mind, however, that limitations might exist on the 
number of values that these programs can import.

Export Feature Data
Exporting feature data is useful if you want to create an fcs file or graph the feature data in a third party graphing applic-
ation.

1.   On the Tools menu, click Export Feature Values. The Export Feature Data window appears.

2.    Add files to the list on the left to export values for multiple files.
3.    In the Select a population drop-down menu, select the population that you want. If you haven’t defined any pop-

ulations, All is the default.
4.    In the Select feature values to export area, select features by clicking items in the list or hold down the Ctrl while 

clicking to select multiple items.
5.    Select the Export to option that you want. 

NOTE: Data exported to the Clipboard can be pasted directly into a spreadsheet program.

6.    Select the Order by option that you want. 

NOTE: Ordering by object causes the values to be listed in a column, whereas ordering by feature causes the val-
ues to be listed in a row.

7.    Click OK. 
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Export Pixel Data
Exporting pixel data is useful when importing the data into third-party programs where you would need to graph the indi-
vidual pixels. 

1.   On the Tools menu, click Export Image Pixel Values. The Export Image Pixel Values window appears. 

2.    Select the object to export in the drop-down menu.
3.    Select to Export to either the Clipboard or File.
4.    Click OK.
5.    Paste into desired application.
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Create TIFs from Population for Export
The IDEAS® application allows users to create separate TIF files for channel images for every event in that population. 
The exported TIF files can be opened in image viewing applications that support 8 bit tif format for display or 16 bit tif 
format for analysis.

1.   On the Tools menu, click Export .tif Images. The Create TIFs From Population window displays.

2.    Select the population and channels. 
3.    Type a prefix for the TIF file name in the File name prefix field. 
4.    Select the bit depth in the Bit Depth section.
5.    Select padded or raw in the Pixel Data section.
6.    Click OK. A TIF file is created for every selected channel within the selected population. 

Print Data

Print Analysis Area Data
Select Reports > Print Analysis Report.

The IDEAS® application prints all the graphs, statistics, text panels, and images that are displayed in the Analysis Area. 
In IDEAS version 6.2 and later, additional information has been added to the printed report to assist users in tracking 
changes that may have been made in the files. This includes laser information, compensation matrix and region coordin-
ates.
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Print Image Gallery Data
Select Reports > Print Image Gallery. The IDEAS application prints all the images that are visible in the Image Gallery.

Print an Individual Graph
1.   Right-click the graph and then select Print Graph on the graph context menu. The Print Graph window displays.

2.    Select the check boxes Graph, Statistics, Legend, Cursor, Show Sample Name in Title to include the elements in the 
report. 

3.    If necessary, adjust the size scaling factor. The recommended setting is 100%.
4.    Click OK to print the graph.
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Chapter 4: Features and Masks

This chapter describes the features that the IDEAS® application uses for data analysis:

Overview of the IDEAS® Features and Masks

Objects passing through a Luminex® cell analysis system are illuminated in different directions by lasers and/or bright-
field LEDs. Light emitted from the object is focused through an objective lens and relayed to a spectral decomposition ele-
ment, which divides the light into six spectral bands located side-by-side across a charge-coupled detector (CCD), as 
shown in the following diagram. Therefore, each object has six images that can be individually analyzed or, because they 
are in spatial register with respect to one another, reconstructed. Each of the separate bands is called a channel. Below 
is an example of collecting 6 images. The ImageStreamX® system has a second camera option which enables collection 
of up to 12 images per object. The FlowSight® system has 12 channels collection on 1 camera.

About Features
The IDEAS® application provides a large selection of criteria, or features, for analyzing images. A feature is described by 
a mathematical expression that contains quantitative and positional information about the image. A feature is applied to 
specific locations of an image by the use of a mask that identifies pixels within the region of interest of the image. A few 
system features, such as Object Number, Camera Background and Flow Speed, do not require calculations, masks, or 
image intensity information. 
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There is a slight difference in features created during data acquisition and those in IDEAS. During acquisition features 
are created with the INSPIRE™ mask. Features and masks are calculated in IDEAS for files collected with the 
ImageStream®.

New masks and features can be created in files from an ImageStream  using the Mask and Feature Manager tools. 
Features are created in IDEAS using base feature algorithms, such as Area or Intensity along with a mask and/or a chan-
nel image for files created with an ImageStream machine. The default masks are recomputed in IDEAS for 
ImageStream or FlowSight. Combined features can be created using existing features in mathematical expressions in 
the Feature Manager.

IDEAS groups the features into eight categories: size, location, shape, texture, signal strength, comparison, system and 
combined. 

To calculate the value of a feature, the IDEAS application maps the channel image to X and Y coordinates, as illustrated 
by the following diagram. Each box in the diagram represents a pixel.

The pixel size and field of view per channel is dependent on the magnification used. See the INSPIRE™ User Manual for 
more information.

Feature Categories

Size
Size features are in microns and include Area, Diameter, Length, Major Axis, Minor Axis, Major Axis Intensity, Minor 
Axis Intensity, Perimeter, Thickness Max and Min, Spot Area Min, Width and Height.

Location
Location features include Angle, Angle Intensity, Centroid X, Centroid Y, Centroid X Intensity, Centroid Y Intensity, Delta 
Centroid X, Delta Centroid Y, Delta Centroid XY, Max Contour position, Spot Distance Min, Valley X and Valley Y.
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Shape
Shape features define the mask shape and have units that vary with the feature. They include the Aspect Ratio, Aspect 
Ratio Intensity, Compactness, Elongatedness, Lobe Count, and Symmetry 2,3,4. 

Texture
The Texture features determine local intensity variations in images and include Bright Detail Intensity R3 and Bright 
Detail Intensity R7, Contrast, Gradient Max, Gradient RMS, H Texture (H-Contrast, H-Correlation, H-Energy, H-Entropy, 
H-Homogeneity, and H-Variance), Modulation, Spot Count, and Std Dev. 

Contrast, Gradient Max and Gradient RMS are generally used to determine best focus.

Comparison
The Comparison features describe the difference of intensity measurements between masks or pixels in different 
images or the same image with different masks. These include Bright Detail Colocalization 3, Bright Detail Similarity R3, 
Intensity Concentration Ratio, Internalization, and Similarity.

System
The system features do not require a mask.
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Base Features - Alphabetical 
Table 17. Table of Base Features - Alphabetical

Feature Name Category

Angle Feature Location

Area Feature Size

Aspect Ratio Feature Shape

Aspect Ratio Intensity Feature Shape

Bkgd Mean Feature Signal Strength

Bkgd StdDev Feature Signal Strength

Bright Detail Intensity R3 and Bright Detail Intensity R7 Features Signal Strength

Bright Detail Similarity R3 Feature Comparison

Camera Line Number Feature System

Camera Timer Feature System

Centroid Features Location

Centroid X Intensity and Centroid Y Intensity Features Location

Circularity Feature Shape

Compactness Feature Shape

Contrast Feature Texture

Delta Centroid X and Delta Centroid Y Features Location

Delta Centroid XY Feature Location

Diameter Feature Size

Elongatedness Feature Shape

Ensquared Energy Feature Texture

Flow Speed Feature System
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Feature Name Category

Gradient Max Feature Texture

Gradient RMS Feature Texture

Height Feature Size

H Texture Features Texture

Intensity Concentration Ratio Feature Comparison

Intensity Feature Signal Strength

Internalization Feature Comparison

Length Feature Size

Lobe Count Feature Shape

Major Axis and Minor Axis Features Size

Major Axis Intensity and Minor Axis Intensity Features Size

Max Contour Position Feature Location

Max Pixel Feature Signal Strength

Mean Pixel Feature Signal Strength

Median Pixel Feature Signal Strength

Min Pixel Feature Signal Strength

Major Axis Intensity and Minor Axis Intensity Features Size

Modulation Feature Texture

Object Number Feature System

Objects/ml Feature System

Objects/sec Feature System

Perimeter Feature Size

Raw Centroid Features Location

Raw Intensity Feature Signal Strength
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Feature Name Category

Raw Max Pixel Feature Signal Strength

Raw Mean Pixel Feature Signal Strength

Raw Min Pixel Feature Signal Strength

Raw Median Pixel Feature Signal Strength

Saturation Count Feature Signal Strength

Saturation Percent Features Signal Strength

Shape Ratio Feature Shape

Shift X and Shift Y Features. Location

Shift Features Comparison

Similarity Feature Comparison

Spot Area Min Feature Size

Spot Count Feature Texture

Spot Distance Min Feature Location

Spot Intensity Min and Spot Intensity Max Features Signal Strength

Std Dev Feature Texture

Symmetry 2, 3, 4 Features Texture

Thickness Max Feature Size

Thickness Min Feature. Size

Time Feature System

Valley X and Valley Y Features Location

Width Feature Size

XCorr Feature Comparison
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Base Features by Category 
Table 18. List of Features by category

Feature 
Category Feature Name and Description In Default 

Template?

In Expanded 
Default 

Template?

Mask Image 
Used in Default 

Template                     

Size Size-based Features are in microns. - - -

 

Area Feature

The size of the mask in square microns.

Yes Yes M01-M12,MC

 

Diameter Feature

Estimates the diameter of the mask based on 
Area.

No Yes M01-M12

 

Height Feature

Based on a bounding rectangle, the Width is the 
smaller side and the Height is the longer side of 
the rectangle.

Yes Yes M01-M12

 

Length Feature

Measures the longest part of the mask.

Yes Yes M01-M12

 

Major Axis and Minor Axis Features

Describes the widest part of the mask and the 
narrowest part of the mask, respectively.

No Yes M01-M12

 

Major Axis Intensity and Minor Axis Intensity 
Features

Based on a bounding ellipse, the Minor Axis is 
the narrow part and the Major Axis is the widest 
part.

No Yes M01_Ch01-M12_
Ch12
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Feature 
Category Feature Name and Description In Default 

Template?

In Expanded 
Default 

Template?

Mask Image 
Used in Default 

Template                     

 

Perimeter Feature

Describes circumference of the mask.

No Yes M01-M12

 

Spot Area Min Feature

The Area of the smallest spot in the mask.

No No -

 

Thickness Max Feature

Describes the longest width of the mask.

No Yes M01-M12

 

Thickness Min Feature

Describes the shortest width of the mask.

No Yes M01-M12

 

Width Feature

Based on a bounding rectangle, the Width is the 
smaller side and the Height is the longer side of 
the rectangle.

Yes Yes M01-M12

Location
Location Features are in X,Y pixel coordinates 
from an origin in the upper left corner, pixels or 
contour 

- - -

 

Angle Feature

The angle of the major axis from a horizontal 
plane in radians.

No No -

 

Angle Intensity Feature

The angle of the major axis intensity from a hori-
zontal plane in radians.

No No -
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Feature 
Category Feature Name and Description In Default 

Template?

In Expanded 
Default 

Template?

Mask Image 
Used in Default 

Template                     

 

Centroid Features

The central tendency of the pixels along the X 
Axis and Y Axis, respectively.

No Yes M01-M12

 

Centroid X Intensity and Centroid Y Intensity 
Features

The central tendency of the pixels along the X 
Axis and Y Axis, respectively, with the pixel 
intensities weighted.

No Yes M01_Ch01-M12_
Ch12

 

Delta Centroid X and Delta Centroid Y Features

The distance between the X or Y Centroids of 
two images.

No No -

 

Delta Centroid XY Feature

The distance between the Centroids of two 
images.

No No -

 

Max Contour Position Feature

The location of the contour in the cell that has 
the highest intensity concentration.

No No -

 

Shift X and Shift Y Features

The shift required to get the highest cross-cor-
relation valu ebetween two images.

No No -

 

Spot Distance Min Feature

The shortest distance between two components 
(spots).

Yes No -
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Feature 
Category Feature Name and Description In Default 

Template?

In Expanded 
Default 

Template?

Mask Image 
Used in Default 

Template                     

 

Valley X and Valley Y Features

The (X,Y) coordinates of the minimum intensity 
within the skeletal lines that are used when cre-
ating the Valley Mask.

No No -

Shape Shape Features define the mask shape and have 
units that vary with the feature. - - -

 

Aspect Ratio Feature

The ratio of the Minor Axis divided by the Major 
Axis.

Yes Yes M01-M12

 

Aspect Ratio Intensity Feature

The ratio of the Minor Axis Intensity divided by 
the Major Axis Intensity.

Yes Yes M01_Ch01-M12_
Ch12

 

Circularity Feature

The degree of the mask’s deviation from a circle.

No No -

 

Density Feature

Describes the density of intensities within the 
object.

No No -

 

Elongatedness Feature

The ratio of the Height/Width which use the 
bounding box.

No Yes M01-M12

 

Lobe Count Feature

The number of lobes in a cell.

No No -
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Feature 
Category Feature Name and Description In Default 

Template?

In Expanded 
Default 

Template?

Mask Image 
Used in Default 

Template                     

 

Shape Ratio Feature

The ratio of Thickness Min/Length features.

No Yes M01-M12

 

Symmetry 2, 3, 4 Features

These three features measure the tendency of 
the object to have a single axis of elongation, a 
three-fold and a four-fold variation of the 
shapes.

No No -

Texture
Texture features measure pixel or regional vari-
ation and indicate the granularity or complexity 
of the image. 

- - -

 

Bright Detail Intensity R3 and Bright detail Intens-
ity R7 Features

The Intensity of the pixels in the bright detail 
image using a 3 or 7 pixel structuring element.

Yes (R3)

No (R7)

Yes MC_Ch1-MC_Ch6

 

Contrast Feature

Enumerates changes of pixel values in the image 
to measure the focus quality of an image.

Yes Yes M01_Ch01-M12_
Ch12

 

Gradient Max Feature

The maximum slope of the pixel value changes 
in the image to measure focus quality of an 
image.

No Yes M01_Ch01-M12_
Ch12

 

Gradient RMS Feature

Enumerates changes of pixel values in the image 
to measure the focus quality of an image.

Yes Yes M01_Ch01-M12_
Ch12
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Feature 
Category Feature Name and Description In Default 

Template?

In Expanded 
Default 

Template?

Mask Image 
Used in Default 

Template                     

 

H Texture Features

Measures Haralick texture features.

No Yes M01_Ch01_5-M12_
Ch12_5

 

Modulation Feature

Measures the intensity range of an image, nor-
malized between 0 and 1.

Yes Yes M01_Ch01-M12_
Ch12

 

Spot Count Feature

Enumerates the number of spots.

No No -

 

Std Dev Feature

Describes the overall distribution of pixel intens-
ities. 

No Yes M01_Ch01-M12_
Ch12

Signal Strength Signal Strength Features are measured in pixel 
values. - - -

 

Bkgd Mean Feature

The average intensity of the camera back-
ground.

Yes Yes Ch01-Ch12

 

Bkgd StdDev Feature

The standard deviation of the background intens-
ities.

No Yes Ch01-Ch12

 

Intensity Feature

The sum of the pixel intensities in the mask, back-
ground subtracted.

Yes Yes MC_Ch01-MC_
Ch12
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Feature 
Category Feature Name and Description In Default 

Template?

In Expanded 
Default 

Template?

Mask Image 
Used in Default 

Template                     

 

Max Pixel Feature

The largest pixel value within the mask, back-
ground subtracted.

Yes Yes MC_Ch01-MC_
Ch12

 

Mean Pixel Feature

The average pixel value within the mask, back-
ground subtracted.

Yes Yes M01_Ch01-M12_
Ch12

 

Median Pixel Feature

The median pixel value within the mask, back-
ground subtracted.

Yes Yes M01_Ch01-M12_
Ch12

 

Min Pixel Feature

The smallest pixel value within the mask, back-
ground subtracted.

No No -

 

Raw Intensity Feature

The sum of the pixel intensities within the mask.

No No -

 

Raw Max Pixel Feature

The largest pixel intensity. 

Yes Yes MC_Ch01-MC_
Ch12

 

Raw Mean Pixel Feature

The average pixel intensity: Raw does not have 
background subtracted. 

No No -

 

Raw Median Pixel Feature

The median pixel intensity. 

No No -
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Feature 
Category Feature Name and Description In Default 

Template?

In Expanded 
Default 

Template?

Mask Image 
Used in Default 

Template                     

 

Raw Min Pixel Feature

The lowest pixel value within the mask.

Yes Yes MC_Ch01-MC_
Ch12

 

Saturation Count Feature

The number of pixels in the mask that are sat-
urated.

Yes Yes M01_Ch01-M12_
Ch12

 

Saturation Percent Features

The Percentage of pixels in the mask that are sat-
urated.

Yes Yes -

 

Spot Intensity Min and Spot Intensity Max 
Features

The raw intensity (not background subtracted) 
of the dimmest component (spot).

No No -

Comparison Difference of intensity measurements between 
masks or pixels. - - -

 

Bright Detail Colocalization 3

Measures the colocalization of 3 image channels

No No -

 

Bright Detail Similarity R3 Feature

Measures the correlation of the bright details 
between image pairs.

No No -

 

Intensity Concentration Ratio Feature

Given two masks, the ratio of the intensity in one 
mask to the total intensity in both masks.

No No -
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Feature 
Category Feature Name and Description In Default 

Template?

In Expanded 
Default 

Template?

Mask Image 
Used in Default 

Template                     

 

Internalization Feature

The ratio of the intensity inside the cell to the 
intensity of the entire cell.

No No -

 

Similarity Feature

The Similarity is a measure of the degree to 
which two images are linearly correlated pixel 
by pixel within a masked region.

No No -

 

XCorr Feature

The XCorr is a measure of the degree to which 
two images frequencies are cross correlated.

No No -

System System features do not require a mask and tend 
to deal with system wide metrics. - - -

 

Camera Line Number Feature

An incremental count of objects. 

No Yes -

 

Camera Timer Feature

The clock rate in KHz. This is relative time. 

No Yes -

 

Flow Speed Feature

The calculated flow speed in mm/sec. 

Yes Yes -

 

Object Number Feature

The sequence of objects.

Yes Yes -
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Feature 
Category Feature Name and Description In Default 

Template?

In Expanded 
Default 

Template?

Mask Image 
Used in Default 

Template                     

 

Objects/ml Feature

A local concentration of all objects per ml. 

NOTE: to get objects per ml of a population, use 
the statistic ‘Concentration’.

No Yes -

 

Objects/sec Feature

A local concentration of number of objects per 
second. Note: to get objects per ml of a pop-
ulation, use the statistic ‘Concentration’

No Yes -

 

Time Feature

The camera timer feature, converted to 
seconds.

Yes Yes -

Combined Any combined feature will be listed under Com-
bined No No -
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Size Features
Size features are in microns and include Area, Diameter, Length, Major Axis, Minor Asix, Major Axis Intensity, Minor 
Axis Intensity, Perimeter, Thickness Max and Min, Spot Area Min, Width and Height.

Area Feature
The number of microns squared in a mask is equal to the Area. In the following figure, a 1 symbolizes whether the area 
is included in the mask. The number of pixels is converted to µm2. Note that 1 pixel = 0.25 µm2. As an example, a cell 
with a mask that includes 2000 pixels is therefore equal to 500 µm2.

Application Examples
 l Quantify and compare cell size.
 l Identify single cells.
 l Calculate the radius, diameter and volume of the cell.
 l Identify apoptosis using the Area of the 30% threshold mask of a nuclear dye.
 l Create a pseudo FSC va. SSC plot for comparing with flow cytometry.
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Diameter Feature
The Diameter feature provides the diameter of the circle that has the same area as the object. The accuracy of the dia-
meter is highly dependent on a close fitting mask and roundness of the cell. 

The images below depicts beads with a uniform diameter of 9 microns.

In the next figure, note that images with longer shapes that have the same area will have the same diameter value.

Application Example:  
 l Used to obtain approximate size of the cell.
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Height Feature
Using the bounding rectangle, Height is the number of microns of the longer side and Width the shorter side.

Application Example
 l These features can be used to separate rectangular shaped objects. For curved objects, measurement is more 

accurately obtained using the thickness features.
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Length Feature
Length measures the longest part of an object. Unlike the Major Axis feature, Length can measure the object's length 
even if it folds to form a cashew, banana, or doughnut shape, where in many of these cases the major or minor axis fea-
tures would not be able to differentiate these with true circular shaped objects with no hole.

This feature is based on an input mask and is sensitive to the variation of the input mask shape. Selecting an input mask 
that can accurately capture the object shape is important.
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Major Axis and Minor Axis Features
The Major Axis is the longest dimension of an ellipse of best fit. The Minor Axis is the narrowest dimension of the ellipse 
of best fit.

Application Examples:
 l Quantify and compare cell shape.
 l Identify small, medium, and large cells.
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Major Axis Intensity and Minor Axis Intensity Features
The Major Axis Intensity is the longest dimension of an ellipse of best fit and is intensity weighted. The Minor Axis Intens-
ity is the narrowest dimension of the ellipse of best fit and is intensity weighted. 

The figure below illustrates the difference between intensity weighted and non-intensity weighted Major or Minor Axis 
and Aspect Ratio.

Application Examples
 l Quantify and compare the image fluorescence shape.
 l Identify single cells.
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Perimeter Feature
The perimeter feature measures the boundary length of the mask in the number of microns. 

This example uses a 1-pixel wide mask created to illustrate how a perimeter would appear.

Application Examples
 l Quantify and compare cell circumference.
 l Identify cells with highly irregular surfaces from smooth cells.
 l Perimeter of the morphology or threshold masks can identify cells with or without dendrites.
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Spot Area Min Feature
The Spot Area Min feature provides the area of the smallest spot (connected component) in a spot or peak mask. 

This is one of four features that can be used to identify objects with spots that are close together, dim, bright or small 
when counting spots in an image. To use these features, the spots need to be individually masked, such as using the Spot 
or Peak Mask. The Spot Area Min, Spot Distance Min, and Spot Intensity Min or Max features measure properties of dif-
ferent spots in an image and are often used with the Spot Count feature (under Texture).

 

 l Spot Area Min is the Area of spot 1
 l Spot Distance Min is distance 2 in microns
 l Spot Intensity Max is the Raw Mean Pixel of spot 2
 l Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example
 l In FISH Spot Counting, these features are used to identify objects with ambiguous spots that are located too 

close together, are too dim to count or are too small in order to remove these objects from the analysis.
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Thickness Max Feature
Thickness Max measures the largest width of an object. This feature is based on an input mask and therefore sensitive 
to the variation of the input mask shape. Selecting an input mask that can accurately capture the object shape is import-
ant.

Thickness Min Feature
Thickness Min measures the smallest width of an object. This feature is based on an input mask and therefore sensitive 
to the variation of the input mask shape. Selecting an input mask that can accurately capture the object shape is import-
ant.
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Width Feature
Using the bounding rectangle, Width is the number of microns of the smaller side and Height the longer side.

Application Example
 l These features can be used to separate rectangular shaped objects. For curved objects, measurement is more 

accurately obtained using the thickness features.
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Location Features
Location features include Angle, Angle Intensity, Centroid X, Centroid Y, Centroid X Intensity, Centroid Y Intensity, Delta 
Centroid X, Delta Centroid Y, Delta Centroid XY, Max Contour position, Spot Distance Min, Valley X and Valley Y.

Angle Feature
Angle is the angle of the major axis from a horizontal plane in radians.

Application Example 
 l Identify the orientation of an image relative to the image frame.
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Centroid X and Centroid Y Features
Centroid X is the number of pixels in the horizontal axis from the upper, left corner of the image to the center of the 
mask. Centroid Y is the number of pixels in the vertical axis from the upper, left corner of the image to the center of the 
mask. 

In this example, the Centroid X=54 and the Centroid Y=32.

Application Examples
 l Identify the center of the mask.
 l Calculate the Delta Centroid or the distance between two fluorescent markers.
 l Used by IDEAS® to calculate the Delta Centroid X, Y, or XY.
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Centroid X Intensity and Centroid Y Intensity Features
Centroid X Intensity is the intensity weighted X centroid and is shifted from the center of the mask toward the center of 
fluorescence. The Centroid Y Intensity is the intensity weighted Y centroid.  X and Y pixel coordinates are calculated from 
an origin in the upper left corner.

Application Examples
 l Identify the center of peak fluorescence.
 l Calculate the distance between two fluorescent markers.
 l Used by IDEAS® to calculate the intensity weighted Delta Centroid X, Y or XY.
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Delta Centroid X and Delta Centroid Y Features
Both the Delta Centroid X and Y features measure the distance between the Centroids X or Centroids Y, respectively, of 
two images using the user-provided masks for each image. Either one or both the centroids of the images may be intens-
ity-weighted. X and Y pixel coordinates are calculated from an origin in the upper left corner to obtain the centroid pos-
itions and the distance between the centroids is converted to microns.
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The graph below illustrates using the Delta Centroid X versus Delta Centroid Y to identify cells with a variation of loc-
ation of a protein with respect to the nucleus.

Cells with no spatial shift of signal between the nuclear stain(Ch6) and protein of interest(Ch4) have a low Delta Cen-
troid X and Y and are found in the lower left corner. Cells with a large shift between the images in both the X and Y dir-
ection are found in the upper, right section and those with a large shift in X but not Y are found in the lower, right. 
Similarly a cell with a large shift in the Y direction and not X are found in the upper, left. 

Application Example
 l Used to identify capped versus not capped cells.
 l Used to measure shifts in X or Y direction between two images.
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Delta Centroid XY Feature
The Delta Centroid XY feature measures the distance between the Centroid feature of two images using the user-
provided masks for each image. Either one or both the centroids of the images may be intensity-weighted. X and Y pixel 
coordinates are calculated from an origin in the upper left corner to obtain the centroid positions and the distance 
between the centroids is converted to microns. In the example, below an image pair is shown stained with the nuclear 
dye Draq 5 and a PE labeled antibody that is differentially expressed two cells, either uniformly or in the pseudopod. The 
two cells are identified by their different Delta Centroid XY values.
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Below is an example of using the Delta Centroid XY. A bivariate graph of a shape ratio versus Delta Centroid XY can 
identify cells with caps as shown here:

Application Examples
 l Quantify the spatial relationship between two fluorescent probes.
 l Identify false apoptotic positive cells in the TUNEL and Annexin V assays.
 l Quantify shape change.
 l Quantify capping of cell surface antigens.

Raw Centroid X  and Raw Centroid Y Features
The centroid X and Y of the original position of the image during acquisition before it was centered IDEAS®. Data ana-
lyzed in IDEAS versions 4.0 or later cut and center objects that were collected as one image in INSPIRE™.
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Max Contour Position Feature
The Max Contour Position is defined as the location of the contour in the cell that has the highest intensity concentration. 
It is invariant to object size and can accommodate localized intensity concentrations. The actual location in the object is 
mapped to a number between 0 and 1, with 0 being the object center and 1 being the object perimeter, which allows one 
to compare the results across cells of different sizes. An example is shown below. 

Application Example
 l Used in conjunction with the Internalization feature to determine the distribution of intensity within a cell.

Shift X and Shift Y Features
The Shift X or Shift Y feature is the location of the highest cross-correlation of a pair of images. When two identical 
images are aligned perfectly the cross-correlation is at it's maximum. The Shift X or Shift Y is the shift required to get the 
highest cross-correlation value for the 2 images. This feature is used mainly for troubleshooting cross-camera align-
ment.
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Spot Distance Min Feature
The Spot Distance Min feature provides the shortest distance in microns between two spots (connected components) in 
a spot or peak mask. 

This is one of four features that can be used to identify objects with spots that are close together, dim, bright or small 
when counting spots in an image. To use these features, the spots need to be individually masked, such as using the Spot 
or Peak Mask. The Spot Area, Distance, and Spot Intensity Min or Max features measure properties of different spots in 
an image and are often used with the Spot Count feature (under Texture).

 l Spot Area Min is the Area of spot 1
 l Spot Distance Min is distance 2 in microns
 l Spot Intensity Max is the Raw Mean Pixel of spot 2
 l Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example
 l In FISH Spot Counting, these features are used to identify ambiguous spots that are located too close together, 

too dim, to bright or too small to count  and can be eliminated from the analysis.
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Valley X and Valley Y Features
The Valley X and Y are the exact X,Y coordinates of the minimum intensity within the skeletal lines of the input mask. 
The objects condensed shape, typically 1-pixel wide skeletal line is determined from the starting mask. This is also the ori-
gin of the Valley mask.

In the figure below, the Valley X and Valley Y position of the 7AAD image is shown. In this example a protein of interest 
in the PE image localizes to the synapse between two cells.

These features define the origin of the Valley mask.

Application Example
 l Measure the exact center of where a synapse between two cells is located.

For Research Use Only. Not for use in diagnostic procedures. 172

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



Shape Features
Shape features define the mask shape and have units that vary with the feature. They include the Aspect Ratio, Aspect 
Ratio Intensity, Compactness, Elongatedness, Lobe Count, and Symmetry 2,3,4. 

Aspect Ratio Feature
Aspect Ratio is the Minor Axis divided by the Major Axis and describes how round or oblong an object is.

Application Examples
 l Quantify the roundness of the mask.
 l Identify single cells vs. doublets.
 l Cell classification based on shape change.
 l Identify recently divided cells in mitosis.
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Aspect Ratio Intensity Feature
Aspect Ratio Intensity is the Minor Axis Intensity divided by the Major Axis Intensity.

The figure below illustrates the difference between Aspect Ratio Intensity and Aspect Ratio.

Application Examples
 l Quantify the roundness of the fluorescent image.
 l Better resolution for identifying single cells vs. doublets in experiments using a DNA dye.
 l Cell classification based on fluorescent morphology.
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Circularity Feature
This feature measures the degree of the mask’s deviation from a circle. Its measurement is based on the average dis-
tance of the object boundary from its center divided by the variation of this distance. Thus, the closer the object to a 
circle, the smaller the variation and therefore the feature value will be high. Vice versa, the more the shape deviates 
from a circle, the higher the variation and therefore the Circularity value will be low.  

Below is an example using Circularity and Compactness to characterize the shape of peripheral blood mononuclear cells 
stained with the DNA dye Draq 5.

Application Examples
 l Distinguish singlets and doublets.
 l Separate circular and non circular shapes.
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Compactness Feature
Compactness measures the degree of how well the object is packed together. This feature is similar to the Circularity 
feature but unlike Circularity, this feature includes all of the pixels within the mask and is intensity weighted. The higher 
the value, the more condensed the object. 

Below is an example using Circularity and Compactness to characterize the shape of peripheral blood mononuclear cells 
stained with the DNA dye Draq 5.

Application Example: 
 l Differentiate between rounded objects with smooth boundary to less regular objects.
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Elongatedness Feature
Elongatedness is the ratio of the Height over Width of the object’s bounding box. 

Application Examples
 l Measure object shape properties to differentiate between long and narrow versus short and thick objects.
 l Quantify the roundness of the morphology mask.
 l Identify single cells and doublets.
 l Cell classification based on shape change.
 l Identify recently divided cells in mitosis.
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Lobe Count Feature
The Lobe Count feature counts the number of lobes in a cell. It is determined based on the maxima of the weighted Sym-
metry features. The feature reports the values 1,2,3 or 4. If an object does not have a high value for Symmetry 2, Sym-
metry 3, or Symmetry 4 it is reported as 1 for no lobes. An example is shown below.

Application Example
 l Used in cell classification studies. Also used to differentiate small round cells from small square cells of similar 

area.
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Shape Ratio Feature
The Shape Ratio is Thickness Min divided by Length. 

The Shape Ratio feature is based on an input mask and is sensitive to the variation of the input mask shape. Selecting an 
input mask that can accurately capture the object shape is important.

Application Example 
 l Measure object's elongatedness to provide shape classification.
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Symmetry 2, 3, 4 Features
The Symmetry 2 feature measures the tendency of the object to have a single axis of elongation and therefore 2 lobes. 
The Symmetry 3 feature measures the tendency of the object to have a three-fold axis of symmetry and likewise, Sym-
metry 4 a four-fold axis. The absolute value of these features are dependent on the number of lobes. For example an 
image that has high 4 lobe symmetry will also have high 2 lobe symmetry.

Application Example
 l Classify different white blood cells based on the morphology of the nuclear image.
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Texture Features
The Texture features determine local intensity variations in images and include Bright Detail Intensity R3 and Bright 
Detail Intensity R7, Contrast, Gradient Max, Gradient RMS, H Texture (H-Contrast, H-Correlation, H-Energy, H-Entropy, 
H-Homogeneity, and H-Variance), Modulation, Spot Count, and Std Dev. 

Contrast, Gradient Max and Gradient RMS are generally used to determine best focus.

Bright Detail Intensity R3 and Bright Detail Intensity R7 Features
The Bright Detail Intensity R3 and Bright Detail Intensity R7 features compute the intensity of localized bright spots 
within the masked area in the image. Bright Detail Intensity R3 computes the intensity of bright spots that are 3 pixels in 
radius or less, while Bright Detail Intensity R7 computes the intensity of bright spots in the image that are 7 pixels in 
radius or less. In each case, the local background around the spots is removed before the intensity computation.

The figure below shows the process of obtaining the localized bright spots in the image.
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The graph below illustrates the use of the Bright Detail Intensity R3 feature on a nuclear image to separate apoptotic 
cells from non-apoptotic cells.

Application Example 
 l Identify cells that have bright specks such as Apoptotic cells.
 l Used in the Cell Cycle - Mitosis Wizard.
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Contrast Feature
The Contrast feature measures the sharpness quality of an image by detecting large changes of pixel values in the 
image and is useful for the selection of focused objects or apoptotic brightfield images. For every pixel, the slopes of the 
pixel intensities are computed using the 3x3 block around the pixel. This is similar to the Gradient RMS calculation with 
different weighted assignments to the pixel arrays with no background subtraction. Example images are shown in the fig-
ure below. 

Application Examples
 l Find apoptotic images with high contrast in brightfield imagery.
 l Determine overall focus quality of images. 
 l Use with Gradient RMS to determine focus quality.
 l Characterize texture. 

Ensquared Energy Feature
The Ensquared Energy feature is a measure of image quality. Computes the intensity of the square block around the 
brightest pixel using the diameter input as the side for the square divided by the intensity of the total intensity. The closer 
this ratio is to 1.0 the better focused the image. This feature is mainly used for single, uniform particles such as beads.
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Gradient Max Feature
The Gradient Max feature measures the sharpness quality of an image by detecting largest change of pixel values in the 
image and is useful for the selection of focused objects. 

This figure shows the change in intensity across the red line. The top image has a larger slope change than the lower 
image.

Application Example
 l Determine peak focus quality of images. 
 l Also used to characterize texture. However, the Gradient RMS and Contrast feature are more robust for these 

applications.
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Gradient RMS Feature
The Gradient RMS feature measures the sharpness quality of an image by detecting large changes of pixel values in the 
image and is useful for the selection of focused objects. The Gradient RMS feature is computed using the average gradi-
ent of a pixel normalized for variations in intensity levels. This is similar to the Contrast calculation with different 
weighted assignments to the pixel arrays and with background subtracted. Example images are shown in the figure 
below.

Application Examples
 l Determine overall focus quality of images. 
 l Used with Contrast to determine focus quality.
 l Characterize texture. 
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H Texture Features
H Texture features include the following: H Energy Mean and Std, H Entropy Mean and Std, H Contrast Mean and Std, H 
Homogeneity Mean and Std, H Correlation Mean and Std, H Variance Mean and Std Features.

The user defines the texture grain by assigning a granularity value. For very fine textures, this value is small (1-3 pixels), 
while for very coarse textures, it is large (>10). In the IDEAS® default template, the granularity value is 5. 

While these features have value for distinguishing cellular texture when used individually, images often contain a mix-
ture of different textures at different grains. Therefore, these features are most powerful when combined. 

Texture features are used to determine if pixel values in an image follow a pattern or are randomly distributed. An 
image with random grayscale values might look like a gray color swatch with individual pixel values ranging from the min 
to the max centering on a mean. If light and/or dark patterns are visible, it means the pixel values are not randomly dis-
tributed and some texture has emerged.  So texture features can be thought of as measuring the presence or absence of 
randomness.  If pixel values are non-random, then defined patterns are likely to be present in the image. Patterns in the 
image may be biologically significant, such as the clustering of LC3 proteins from a random distribution in the cytoplasm 
as cells enter autophagy, or formation of H2AX clusters in DNA damage and repair studies.

The Haralick texture features are a set of texture features based on the 2nd order statistics computed from the joint 2-D 
probability distribution of pixel intensities in the image. This distribution is referred to as the Gray Level Co-occurrence 
Matrix (GLCM).  To understand how this matrix works, consider the outcome of two dice thrown on a table. The prob-
ability matrix in this case is 6 possible outcomes from the first die and 6 from the second, or 36 possible combinations.  
There are 6 possible doubles and the odds of rolling them are 6/36 or 16.7%. To analyze the texture of images, a sim-
ilar probability matrix can be used to determine if pixels in a given neighborhood occur randomly or (like the toss of two 
dice) are somewhat predictable.  If pixels in an image have a high level of co-occurrence, then there is likely some sort of 
detectable pattern.

Texture features in IDEAS are calculated in a four step process by first converting the pixel data to 8 bits, then applying 
the granularity to calculate the GLCM, next computing the 6 Haralick texture features and finally outputting the mean 
and standard deviation for each of the 6 texture features.

The first step in the three step process is to convert the raw 12 bit image under the bounding mask into a 4 bit image. 
This is done so that the GLCM does not have too many 0 entries which will ensure a more robust estimate of the texture 
and reduce the noise. This effectively bins the raw data into 2^4 or 16 bins with resulting values between 0 and 15. For 
full range images that have pixel values between 0 and 4096 this would bin pixels by 16/4096 or 256 counts, such that 
pixels between 4096 and 3840 would be assigned a value of 15, pixels between 3840 and 3584 would be assigned 14, 
and so on.

Second the granularity is applied to the feature to calculate the GLCM. In IDEAS the granularity defines the distance 
from the anchor pixel to the pixel array used to calculate the texture features. A granularity of 1 would pair the anchor 
pixel with those 1 pixel above, below, right, left and on the angles. The default granularity in IDEAS is set to 5 and for 40x 
imagery this would mean the texture features are comparing pixel pairs 2.5 um away from the anchor pixel
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Next the GLCM is calculated by comparing neighboring pixel values and calculating how uniform or variant those values 
are. The GLCM is a function of the texture granularity d and orientation, q.  The entry pij in the ith row and jth column of 
the GLCM matrix is defined as the probability of having pixel pairs in the image with intensities {i,j} at a distance d from 
each other along an orientation q. Thus, the GLCM is an N x N matrix, where N is determined by the range of intensities 
in the cell. For very fine textures, granularity d is typically very small – about 1-2 pixels. For medium textures, d is about 4-
8. For very coarse textures, d can be very large, about 12-16 pixels. The specific value of the orientation q is less import-
ant in our applications since we are not interested in the actual orientation of the texture, but only if orientation exists. 
For this reason, we compute the GLCM for a number of orientations {0, 45, 90, 135, 180, 225, 270, 315 degrees}. Assum-
ing symmetry in orientation, we combine the orientations (0,180), (90,270), (45,225) and (135,315) to obtain 4 separate 
matrices.

Finally the mean and standard deviation (std) of each texture feature are calculated where the mean is the average 
value at each of the four orientations theta, and the standard deviation is the variation of those values. The mean texture 
values are good indicators of the average texture in the cell, while the standard deviations are good indicators of ori-
entation in the texture. Large standard deviation values indicate that some directions have very different textures from 
other directions.

For Research Use Only. Not for use in diagnostic procedures. 187

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



Texture features have been useful for analyzing changes in staining patters for applications like LC3 clustering in cells 
progressing through autophagy, H2Ax foci formation in DNA damage and repair studies, nuclear condensation and frag-
mentation in apoptotic assays, changes in mitochondrial membrane potential and other applications where a given treat-
ment induces changes in a fluorochromes pattern of staining. For a more detailed description of the Haralick features 
see the paper referenced below.
1Haralick, R.M., K. Shanmugan, and I. Dinstein, "Textural Features for Image Classification", IEEE Transactions on Sys-
tems, Man, and Cybernetics, Vol. SMC-3, 1973, pp. 610-621.
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Contrast measures the intensity variation in a cell. A high mean value indicates that neighboring pixels tend to have very 
different intensity values, and would describe an image with lots of adjacent light and dark areas. Contrast will range 
between 0 and 1.
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Correlation measures how similar pixel pairs are, and is the opposite of contrast.  Images with high correlation will be 
very uniform and lack variant texture.
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Energy is a measure of intensity concentration in the cell. At one extreme is the case where we have a uniform dis-
tribution with all probabilities being equal. This image likely has several intensity variations with no noticeable con-
centration of high intensity and thus has low energy. At the other extreme is the case where we have a very narrow 
distribution with a few elements having high values. This image will have notable intensity concentrations and thus, has 
high energy.
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Entropy is also a measure of high intensity concentration in the cell. However, this feature relates to the randomness of 
the intensities in the image. Images that have distinct areas of intensity concentration are less random and thus, have 
low entropy. Images that have a range of equally likely intensity pairings have less distinct intensity concentrations, and 
correspondingly, have higher entropy. Entropy is the opposite of energy.

For Research Use Only. Not for use in diagnostic procedures. 192

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



Homogeneity is a measure of how close pixels value are, if pixel pairs are the same or similar then a high homogeneity 
value is given. If there are very few pixels with the same value, then a lower homogeneity score is generated. Images 
with high homogeneity would look very uniform and lack texture. Homogeneity is the inverse of contrast and very similar 
to correlation.
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Variance measures the spread of pixel values within the granularity. Images with high variance values will have a large 
spread in pixel intensities visually identified by very dark and very bright spots throughout the image.

Application Example
 l Quantify texture in cells.

1Haralick, R.M., K. Shanmugan, and I. Dinstein, "Textural Features for Image Classification", IEEE Transactions on Systems, 
Man, and Cybernetics, Vol. SMC-3, 1973, pp. 610-621.
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Modulation Feature
The Modulation feature measures the intensity range of an image, normalized between 0 and 1. 

The formula is: Modulation = Max Pixel - Min Pixel / Max Pixel + Min Pixel

The following example illustrates Modulation on brightfield images and Intensity of scatter in channel 1. 

High Modulation

Low Modulation

Application Example 
 l Quantify image quality and characterize contrast and texture in cells.
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Spot Count Feature
The Spot Count feature provides the number of connected components in an image. The connected component 
algorithm examines the connectivity of each pixel based on whether this pixel is connected to a particular spot or the 
background. In order to count the number of connected components the mask input is very important.

The following figure illustrates the application of Spot Counting to quantify parasitic infection of Babesia in erythrocytes 
by staining nuclei with YOYO (green).

For Research Use Only. Not for use in diagnostic procedures. 196

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



Connectivity Option
The spot count feature offers a choice of 4 or 8 connectivity for the connected components algorithm. This option 
determines how a component is defined based on connected pixels. 

The default selection, 4-connectivity (left), only considers neighbor pixels oriented vertically or horizontally from the 
pixel of interest. Pixels are included in the component if the are touching on the diagonal when the option eight is chosen.

Application Examples
 l Counting parasites.
 l Counting phagocytosed particles.
 l FISH spot counting.
 l Counting punctate spots in images.
 l Spot Wizard
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Std Dev Feature
The Std Dev feature describes the overall distribution of pixel intensities.

The Std Dev is the standard deviation of the pixel intensity values in the mask. The Std Dev value provides an indication 
of the texture or complexity of an object.

The following illustrates that apoptotic cells (AnxnV positive) exhibit higher Std Dev values in the darkfield channel (scat-
ter) and higher brightfield Modulation values than non-apoptotic cells (AnxnV negative). 

Application Example 
 l Quantify intensity variation within a mask.
 l Distinguish apoptotic and necrotic cells.
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Signal Strength Features
Signal Strength features include the following: 

 l Bkgd Mean and Bkgd StdDev features describe the background of the image.
 l Intensity and Raw Intensity features quantify the intensities in the region of interest. 
 l Raw Max, Raw Min, Raw Mean and Raw Median Pixel report single pixel values in an image.
 l Max, Min, Mean and Median Pixel report background subtracted single pixel values in an image. 
 l Saturation Count and Saturation Percent quantify the saturated pixels.
 l Spot Intensity Min is used when counting spots.

NOTE: When the name includes ‘Raw’, this means that there is no background subtraction.

Bkgd Mean Feature
The Bkgd Mean feature estimates the average camera background level in an image by taking the mean of the back-
ground pixels. 

Application Examples
 l Obtain estimate of the mean camera background level. 
 l Compute background-subtracted pixel values in other feature computations.

Bkgd StdDev Feature
The Bkgd Std Dev feature estimates the standard deviation of the camera background level in an image computed using 
the background pixels.

Application Example 
 l Obtain estimate of the camera background noise. 
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Intensity Feature
The Intensity feature is the sum of the background subtracted pixel values within the masked area of the image.

Application Examples
 l Quantify relative levels of fluorescence between cells and within different regions of the same cell.
 l Immunophenotyping.
 l Cell cycle analysis.
 l Protein expression.
 l Protein activation.
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Max Pixel Feature
The Max Pixel feature is the largest value of the background-subtracted pixels contained in the input mask. An example 
plot is shown below that demonstrates the advantage of using this feature over the Intensity feature for identifying true 
positive events. For a concentrated signal, Max Pixel is more sensitive than Intensity as shown in the figure below.

The relationship of Max, Mean, Median, and Min Pixel is shown in the figure below:

Application Examples
 l Used to estimate the true peak fluorescence activity. Is preferred over the Raw Max Pixel for this application. 
 l Max Pixel to Mean Pixel ratio identifies bright punctate staining vs. uniform staining.

For Research Use Only. Not for use in diagnostic procedures. 201

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



Mean Pixel Feature
The Mean Pixel feature is the mean of the background-subtracted pixels contained in the input mask. This is computed 
as Intensity/number of pixels. 

The relationship of Max, Mean, Median and Min Pixel is shown in the figure below:

Application Examples
 l Estimate the average fluorescence activity. This feature is preferred over the Raw Mean Pixel feature.
 l Quantify relative levels of mean fluorescence between cells.
 l Identify bright punctate spots by calculating the max to mean pixel ratio.
 l Track internalization of surface bound antibodies.
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Median Pixel Feature
The Median Pixel feature is the median of the background-subtracted pixels contained in the input mask. It is more 
robust than the mean as an estimate of the average fluorescence since it is less influenced by outliers. 

The relationship of Max, Mean, Median and Min Pixel is shown in the figure below:

Application Example
 l Estimate the average fluorescence activity. This feature is preferred over the Raw Median Pixel feature.
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Min Pixel Feature
The Min Pixel feature is the smallest value of the background-subtracted pixels contained in the input mask. There will 
be some negative numbers due to the background subtraction, therefore the Raw Min Pixel feature is preferred.

Application Examples
 l Obtain the minimum value in an image after background subtraction. Very likely to be negative in brightfield 

imagery.
 l Quantify spectral absorbance using the brightfield image.
 l Identify over compensated images.

Raw Intensity Feature
The Raw Intensity feature is the sum of the pixel values within the mask including camera background. 

Application Example
 l Estimate raw fluorescence activity. This feature is less relevant than the Intensity feature because it includes 

camera background intensity.
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Raw Max Pixel Feature
The Raw Max Pixel feature is the largest value of the pixels contained in the input mask. 

 

Application Examples
 l Determine the presence of saturated events. 
 l May also be used to estimate the peak fluorescence activity, though the Max Pixel feature is recommended for 

this application. 
 l Measure the maximum pixel value within the mask.
 l Identify cells that saturate the CCD, Saturation Count feature can also be used for this application.
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Raw Mean Pixel Feature
The Raw Mean Pixel feature is the mean of the pixels contained in the input mask. This is computed as Raw Intensity of 
pixels. 

Application Example
 l Estimate the raw average fluorescence activity. This feature is less relevant that the Mean Pixel feature.

Raw Median Pixel Feature
The Raw Median Pixel feature is the median of the pixels contained in the input mask. 

Application Example
 l Estimate the raw average fluorescence activity that is robust to outliers. This feature is less relevant than the 

Median Pixel feature. 
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Raw Min Pixel Feature
The Raw Min Pixel feature is the smallest value of the pixels contained in the input mask. The example below illustrates 
quantifying the level of malarial infected cells by using Min Pixel values of brightfield imagery.

Application Example
 l Quantify spectral absorbance using the brightfield image.
 l Identify over compensated images.
 l Measure the level of malaria infection in RBCs.
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Saturation Count Feature
The Saturation Count feature reports the number of saturated pixels in an object.

In the figure below, objects with saturated pixels are lined up at the Raw Max Pixel value of 4095 and a selected image 
is shown with saturated pixels in red. 

Application Example
 l Measure the validity of the experiment setup. Saturated data may not produce useful information.
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Saturation Percent Features
The Saturation Percent feature reports the percentage of saturated pixels in an image. Pixel intensities are measured on 
the camera pixels from 0 to 4095 (12 bit) and therefore become saturated and cannot be quantified after 4095.

An object with saturated pixels shown in red: 

Application Example
 l Measure the validity of the experiment setup. Saturated data may not produce useful information.
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Spot Intensity Min and Spot Intensity Max Features
Spot Intensity Min provides the smallest Raw Mean Pixel value (not background subtracted) of the dimmest spot (con-
nected component). The Raw Mean Pixel values for each spot is computed and the smallest value is reported. 

Spot Intensity Max provides the largest Raw Mean Pixel value (not background subtracted) of the brightest spot (con-
nected component). The Raw Mean Pixel values for each spot is computed and the largest value is reported. 

These are two of four features that can be used to identify objects with spots that are  close together, dim, bright or small 
when counting spots in an image. To use these features, the spots need to be individually masked, such as using the Spot 
or Peak Mask. The Spot Area, Distance, and Intensity Min or Max features measure properties of different spots in an 
image and are often used with the Spot Count feature (under Texture). Spot Area Min (Size) provides the area of the 
smallest spot. Spot Distance Min (Location) provides the shortest distance between two spots.

The following diagram illustrates these features:

 l Spot Area Min is the Area of spot 1
 l Spot Distance Min is distance 2 in microns
 l Spot Intensity Max is the Raw Mean Pixel value of spot 2
 l Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example
 l In FISH Spot Counting, these features are used to identify ambiguous spots that are located too close together, 

too dim, to bright or too small to count and can be eliminated from the analysis.

Uncompensated Intensity Feature
The Uncompensated Intensity feature is the sum of the background subtracted pixel values within the masked area of 
the image with no compensation applied. This is the Intensity of the uncompensated image. This feature is calculated in 
INSPIRE™ during acquisition.

For Research Use Only. Not for use in diagnostic procedures. 210

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



Comparison Features
The Comparison features describe the difference of intensity measurements between masks or pixels in different 
images or the same image with different masks. These include Bright Detail Similarity R3, Intensity Concentration Ratio, 
Internalization, and Similarity.

Bright Detail Similarity R3 Feature
The Bright Detail Similarity R3 feature is designed to specifically to compare the small bright image detail of two images 
and can be used to quantify the co-localization of two probes in a defined region, such as that of endosomes. The Bright 
Detail Similarity R3 feature is the log transformed Pearson’s correlation coefficient of the localized bright spots with a 
radius of 3 pixels or less within the masked area in the two input images. Since the bright spots in the two images are 
either correlated (in the same spatial location) or uncorrelated (in different spatial locations), the correlation coefficient 
varies between 0 (uncorrelated) and 1 (perfect correlation), and does not assume negative values. The coefficient is log 
transformed to increase the dynamic range between {0, inf}.

The following figure shows the Bright Detail Similarity R3 graph of two populations, one that has colocalization and one 
that has no colocalization.

The figure below illustrates the process of obtaining the localized bright spots. The bright areas are eroded from the ori-
ginal image and the detail eroded image is subtracted from the original image resulting in the bright detail image.
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The figure below shows the correlation analysis between an image pair.

Application Examples
 l Quantify the degree of colocalization between two probes.
 l Track internalization and intracellular trafficking of antibody drug conjugates to either the endosomes or the 

lysosomes.
 l Colocalization of Rituxan and compliment C3b.
 l Co-localization Wizard
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Intensity Concentration Ratio Feature
The intensity concentration ratio is defined as the ratio of the intensity inside the first input mask to the intensity of the 
union of the two masks - the higher the score, the greater the concentration of intensity inside the first mask. All pixels 
are background-subtracted. The ratio is invariant to cell size and can accommodate concentrated bright regions and 
small dim spots. The ratio is mapped to a log scale to increase the dynamic range to values between {-inf, inf}. This fea-
ture is a generalization of the Internalization feature.  

Application Example
 l Quantify relative intensity concentrations between different cellular compartments. Internalization is a special 

case of this where the first mask is the internal compartment and the second is the membrane region.
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Internalization Feature
The Internalization feature is defined as the ratio of the intensity inside the cell to the intensity of the entire cell. The 
higher the score, the greater the concentration of intensity inside the cell. All pixels are background-subtracted. The user 
must create a mask to define the inside of the cell for this feature. The feature is invariant to cell size and can accom-
modate concentrated bright regions and small dim spots. The ratio is mapped to a log scale to increase the dynamic 
range to values between {-inf, inf}. Internalized cells typically have positive scores while cells with little internalization 
have negative scores. Cells with scores around 0 have a mix of internalization and membrane intensity. 

Composite Images of brightfield and channel 6 are shown for High, Medium, and Low Internalization values.

Application Examples
 l Quantify internalization when supplied with the internal mask.
 l Quantify the intensity ratio of a region of interest to the whole cell.
 l Internalization Wizard
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Similarity Feature
The Similarity feature is the log transformed Pearson’s Correlation Coefficient and is a measure of the degree to which 
two images are linearly correlated within a masked region. 

The following figure shows two image pairs that are in spatial registry to one another. On the left the NF-kB (green) is 
predominantly located in the cytoplasm of the cell and has a dissimilar distribution compared to the 7-AAD image (red). 
When the intensity of the green is high, the intensity of the red is low and vice versa. The Similarity value for this cell is -
2.067 indicating that the image pair has a high degree of dissimilarity. Analysis of the image pair on the right shows that 
when the intensity of the green is high, the intensity of the red is high and the Similarity value is a high positive number.

Below are examples of cells with varying amounts of similarity between the NFkB image in green and 7-AAD image in 
red shown here as a composite image. The most dissimilar image pairs in the upper left to the most similar image pairs 
in the upper right.

Application Examples
 l Quantify translocation.
 l Identify co-polarization of two probes.
 l Nuclear Localization Wizard
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XCorr Feature
The XCorr feature is a measure of similarity or 'sameness' between two images: the higher the value, the more similar 
the images. It is robust to intensity variations and relative shifts between the images and is typically used with the com-
bined mask MC.  It is computed using the normalized cross correlation between the two input images. 

Application Examples
 l Used as a mask-independent measure of similarity between two images.
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System Features
The system features do not require a mask.

Camera Line Number Feature
The Camera Line Number feature returns the camera line number values. This feature is obtained from INSPIRE™.

Application Example
 l Used in objects per mL feature. 

Camera Timer Feature
The Camera Timer feature returns the camera timer values that are in ticks. This feature is obtained from INSPIRE™.

Application Example
 l Used in Time feature. 

Flow Speed Feature
The Flow Speed is the calculated flow speed, in mm/sec, of the object. 

The Flow Speed feature is the speed of flow of the cells. It is obtained from INSPIRE™. It should be very consistent across 
all cells in a file.

Application Example
 l Determine consistency of flow. 
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Object Number Feature
The Object Number feature denotes the serial number of a cell in a file. 

Application Example
 l Reference an object in a file.

Objects/mL Feature
The Objects per mL feature returns the object concentration with respect to local volume. 

Application Example
 l Monitor the object flow during the run. 

NOTE: Use the statistic Concentration to obtain objects/mL of a population.

Objects/sec Feature
The Objects per sec feature returns the local  object concentration with respect to time. 

Application Example
 l Monitor the throughput during a run. 

NOTE: Use the statistic Concentration to obtain objects/ml of a population.

Time Feature
The Time feature returns the camera timer values that are in ticks, converted to secs with a formula. 

Application Example
 l Obtain the time taken to collect a sample
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Masks
The set of pixels that contains the region of interest is called the mask. In the following picture, the mask consists of the 
set of pixels on the right image that are colored cyan. The cell is represented in the greyscale image on the left. Cal-
culating some feature values, such as the Area value, requires only a mask. Calculating others, such as Intensity value, 
requires a mask and a channel image.

There are three types of masks: Default masks, Combined masks and Function masks:

 l Default masks named M01 through M12 are either created in INSPIRE™ during acquisition or created in 
IDEAS® when a .rif file is opened. The default mask used by INSPIRE™ during acquisition (Inspire) is different 
than the default mask created in IDEAS (Default Object) when a .rif file is opened from an ImageStreamX®. 
These masks are stored in the .cif file and cannot be changed by the user. 

NOTE: Versions of IDEAS prior to 3.0 were using the System function mask with  weight of 5 for the default 
masks which was more permissive and resulted in larger masks. 
Below is an example of the difference between the default masks.

 l Combined masks are created using Boolean logic to combine and subtract masks. For example, the cyto-
plasmic mask is created by taking the brightfield mask and not the morphology mask of the nuclear image.
You can use the Mask Manager to combine masks of different regions or images. The IDEAS application 
default template provides a combined mask named MC that is the union of the pixels from all channel masks 
and a NMC mask that is everything outside of MC. The following illustration shows two channel masks that are 
combined into one mask, which is shown in the right most panel. 
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Below is an example of making a membrane mask using Boolean Logic

 l Function masks are created with user input. There are fourteen types of function masks, Dilate; Erode; Fill; 
Inspire; Intensity; Interface; Morphology; Threshold; Spot; System; Object; Peak; Range; Skeleton; and Valley. 
Each of the functions masks are defined here. 

AdaptiveErode Mask
The AdaptiveErode mask identifies pixels that will form a circle that touch the input boundary with at least a prescribed 
radius threshold. The radius threshold is inversely proportional to the user input. Therefore the larger the input 
threshold value, the smaller the circle radius which will include more pixels and vise versa. The result is an adaptive 
erosion that takes shape into account instead of a strict pixel number erosion.

Application Examples
 l Can be used to identify the head of sperm.
 l Can be used in combination with the default channel mask to mask the cell membrane.
 l Can be used in applications where it is critical to erode a mask based on the shape of the input mask.

Component Mask
Given an input mask with multiple pieces, each piece can be identified as a component based on a selected feature. The 
components can be sorted in ascending or descending order and each ranked order can be chosen as a separate com-
ponent mask. 

Example 1: This object's mask has multiple pieces defined by a LevelSet mask. 
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In this example the area feature is used to define the largest component. The ranking feature is area, sorted descending 
(highest to lowest/ largest to smallest) and the first ranked object is shown, therefore the largest piece. 

Example 2: Here is the image that has a mask with multiple pieces. The mask is shown in blue, on the right side image.

Choosing area as the ranking feature, if the “ascending” sorting order is selected, then the components of the mask will 
be sorted from smallest to largest.

 

Selecting rank 1 in conjunction with an ascending sort order and the area ranking feature will return the smallest com-
ponent, as seen on the left side image. Selecting the “descending” sorting order will return the largest component, as 
seen on the right side image.

 

Application Examples
 l Can be used to identify separate components within a mask
 l Can be used in combination with the Watershed mask to identify an individual cell in a conjugate or dividing 

cell
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 l Features may be calculated on individual components, for example analysis of each daughter cell can be used 
to measure asymmetric cell division

From left to right, no mask, watershed mask, component largest area, component second largest area. This is a jurkat 
cell in telophase.

Dilate Mask
The Dilate mask adds the selected number of pixels to all edges of the starting mask. 

Erode Mask
The Erode mask removes the selected number of pixels from all edges of the starting mask.

Fill Mask
The Fill mask fills in any holes in the starting mask.
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Inspire Mask
The Inspire mask masks pixels above background and is the mask used during data acquisition in INSPIRE™. This mask 
is available to understand what is being masked during collection and is not generally used for feature calculations. 

NOTE: This mask is new in IDEAS® versions 4.0 or later.

Intensity Mask
The Intensity mask masks pixels between the lower and upper raw intensity thresholds not background subtracted.  

In the example below, cell #10678 is bright and cell #11992 is dim. The 50% Threshold mask is similar for both images 
whereas the Intensity mask 250+ is quite different, since only a few pixels in the dim image are greater than 250 counts, 
while most of the metaphase plates in the bright image are masked. 
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Interface Mask
The interface mask identifies pixels in an object where the object is in contact with a second object. Three input para-
meters are defined. First, the mask of one of the objects (cell of interest). Next, the mask that covers both objects (con-
jugate). A close fitting mask using another function mask such as Object (tight) can be used for the cell of interest mask. 
A brightfield mask can be used for the conjugate. Finally, the width of the interface mask from the contact point towards 
the cell of interest is entered.

Examples are shown below:

Application Example: 
 l Used to quantify synapses in T cell APC (antigen presenting cell) conjugates.

For Research Use Only. Not for use in diagnostic procedures. 224

IDEAS® 6.3 Image Data Exploration and Analysis Software User's Manual



LevelSet Mask
The LevelSet mask is an extension of the Morphology mask that identifies pixel in non-homogeneous regions into three 
different levels: dim, middle and bright and the combination of all three.  Contour detailed level can be adjusted such that 
the smaller the scale, the finer the image structure identified by the individual levels. This mask is particularly helpful for 
masking complex brightfield images.

Application Examples
 l Used to mask bright, medium or dim areas of an object
 l Can be used to get a closely fitting mask (combined option) in lieu of object or morphology masks
 l Can be used on brightfield and fluorescent channels

Example 1: From left to right, no mask, LevelSet (Bright), LevelSet (Middle), LevelSet (Dim), Level Set (Combined). This is 
an image of a protein aggregate.

Example 2: The mask on the left is showing the LevelSet mask set to Dim with a contour level of 6. On the right, we are 
showing a middle level with a contour detail of 2. 
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Example 3: Image shows the use of LevelSet Mask with dim (first column), middle level (second column), bright (third 
column), and combined masks (forth column) for each cell.

Morphology Mask
The Morphology mask includes all pixels within the outermost image contour. This mask, which is used in fluorescence 
images, is best used for calculating the values of overall shape-based features.
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Object Mask
The Object mask segments images to closely identify the area corresponding to the cell. It is based on the assumption 
that background pixels exhibit high uniformity to each other. This helps distinguish the background from the cell pixels. 
The mask characterizes the background pixels using a set of features and then segments the image by determining all 
the pixels that deviate from the background feature set. The default option is used for the default segmentation masks. 
The tight option uses a different set of features to characterize the background which results in a tighter fit around the 
cell.

Examples are shown below: 

Image       Object
(default)

Object
(tight)

Application Examples
 l Used to get a close fit around the cellular area (tight option). 
 l Can be used in lieu of the morph mask for applications where the morph is so tight that it provides incomplete 

masking, sometimes splitting cells into two regions, such as a nuclear dye image of cells in anaphase or telo-
phase. 

 l Can be used in lieu of the morphology mask with the Similarity feature when measuring nuclear translocation 
for better separation between untranslocated and translocated cells (tight option). 

 l Used as the default segmentation masks (default option).
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Peak Mask
The Peak mask identifies intensity areas from an image that have local maxima (bright) or minima (dark). Initially, the 
peak mask will identify all peaks in the image. To select peaks which have certain brightness, the spot to cell background 
ratio is used. This is the ratio between the spot pixel value to the mean camera background value in the original image. 

Below is an example of the Peak, bright option.

Application Examples
 l Used with the Spot Count feature to quantify the speckleness of cells.
 l Separate connected spots in a Spot Mask into individual components.

Range Mask
The Range mask provides a capability to select components in an image within a selected size and/or aspect ratio by set-
ting a minimum and maximum area and minimum and maximum aspect ratio. 

Application Examples
 l Use with a Spot Mask to constrain the Spot Count feature to round spots.
 l Use on any other mask that has multiple components to define unwanted objects such as debris, objects that 

are too small or whose shapes are not circular.
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Skeleton Mask
The skeleton mask provides the barebone structure of the object from the starting mask. Two options are available: thin 
or thick skeletons. The thin option produces the condensed shape of the object and typically takes a form of 1-pixel wide 
skeletal line. The thick option is intensity weighted. The thin option is dependent on the shape of starting mask; thick uses 
the pixel intensities and is less sensitive to the shape of the starting mask. The user will need to pay careful attention to 
the starting mask. In the example below the Morphology mask of the image was used as the starting mask for creating 
the skeleton.

Application Examples
 l Thick skeletons can be used with shape-based features such as symmetry to accentuate the shape of an 

object, and provide greater separations.
 l Separate singlets and doublets by computing the area of the thin skeleton mask. We have used the object

(tight) for this case.
 l Nuclear morphology measurements with lobe count feature for cell classification cells.
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Spot Mask
The Spot Mask has two options: bright or dark. The bright option obtains bright regions from an image regardless of the 
intensity differences from one spot to another. The ability to extract bright objects is achieved using an image processing 
step that erodes the image and leaves only the bright areas. The dark option obtains dark regions. The spot to cell back-
ground ratio and minimum and maximum radius are specified by the user. The spot to cell background ratio is the spot 
pixel value divided by the background in the bright detail image. A maximum radius of x and a minimum radius of y 
implies the image contains spots with a thickness less than 2x+1 and greater than 2y+1 pixels.

The figure below illustrates the open residue process. The bright areas are eroded from the original image and the 
detail eroded image is subtracted from the original image resulting in the bright detail image.
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The image pairs below show objects in grayscale next to their corresponding Spot Masks in cyan. Spot masks can be fur-
ther refined using the Peak and/or Range masks.

Application Examples
 l Used with the Spot Count feature to enumerate spots in images such as for FISHIS®.

 l Used with Intensity features to quantify intensity in spots.
 l Dark spot finds valleys in images such as the low intensity between 2 stained nuclei and is useful for finding 

immune synapses.
 l Identifies the dark areas in red blood cells or parasitic infections in brightfield imagery.

System Mask
The System mask segments objects in an image based on a probability model of how pixels should be grouped together. 
The user sets a weight value that defines a loose or tight grouping. A low weight value groups in a more permissive man-
ner.

Shown is an example of a cell with an apoptotic bleb that is not masked with the System mask weight set at 5 but is 
masked with the System mask weight set at 2.

Application Example 
 l Used on brightfield images to capture a low contrast areas such as cells that undergo a blebbing process, tails 

of sperm or other low contrast type of structures.
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Threshold Mask
The Threshold mask is used to exclude pixels, based on a percentage of the range of intensity values as defined by the 
starting mask. The user chooses the starting mask when creating the Threshold mask.

In the example below, cell #10678 is bright and cell #11992 is dim. The 50% Threshold mask is similar for both images 
whereas the Intensity mask 250+ is quite different, since only a few pixels in the dim image are greater than 250 counts, 
while most of the metaphase plates in the bright image are masked.

Application Example 
 l Used with the Area feature to define apoptotic cells in the Apoptosis Wizard.
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Valley Mask
The Valley mask is a rectangular mask that sits between two bright regions in a starting mask, such as between two nuc-
lei. It is constructed by finding the minimum intensity along the skeletal line between these two bright regions. The 
skeletal line is obtained internally using the skeleton (thin) masking. This minimum intensity identifies the intersection 
between the two objects. The mask is drawn perpendicular to this skeletal like. The length of the valley mask rectangle is 
equal to the minor axis of the object and the width of the mask is defined by the user in pixels.

Application Example 
 l Quantify the intensity of a probe in an immune synapse.
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Watershed Mask
The watershed mask is used to separate a single mask into multiple components. There are several user inputs to optim-
ize the mask. Here is the user interface and following is the detailed explanation with examples.

In image 4587 below, there are two components masked together as one. The watershed mask can be used to “erase” 
part of the mask in between the two components.
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If the “intensity weighted” option is selected, the mask will be computed based on the image intensity values.

The watershed algorithm works by treating the image as a surface map and filling it with “water” from the bottom. 
When the pools of water meet, a border is created. Choose “peaks” or “valleys” to set the orientation of bright and dark 
points. If “valleys” is chosen, low intensities will represent low points and high intensities will represent high points. As 
shown below, this results in poor segmentation for this image.

If “peaks” is chosen, then high intensities are used as the basins and low intensities represent high points. This results in 
much better segmentation for this example image.
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The next adjustable parameter is smoothing. A low amount of smoothing can result in over-segmentation, as seen 
below.

A large smoothing value can also result in poor segmentation results.

A good smoothing value will result in the best segmentation results.
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The final parameter is Line Thickness. This sets the thickness of the dividing line between components.

Application Examples
 l Can be used to separate two attached cells based on DNA content, for example cell conjugates or dividing cells
 l Can be used in combination with the component mask to analyze individual cells in conjugates or dividing cells

From left to right: brightfield no mask, DAPI Ch7 no mask, brightfield watershed mask. This a jurkat cell in telophase.
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